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Warranty and Copyright Statement 

Cedars-Sinai Medical Center has taken care to ensure the accuracy of this document. However, Cedars-Sinai Medical Center 
assumes no liability for errors or omissions and reserves the right to make changes without further notice to any products 
herein to improve reliability, function, or design. Cedars-Sinai Medical Center provides this guide without warranty of any kind, 
either implied or expressed, including, but not limited to, the implied warranties of merchantability and fitness for a particular 
purpose. Cedars-Sinai Medical Center may make improvements or changes in the product(s) and/or program(s) described in 
this manual at any time. 

This document contains proprietary information which is protected by copyright. All rights are reserved. No part of this manual 
may be photocopied, reproduced, or translated to another language without written permission from Cedars-Sinai Medical 
Center. 

Cedars-Sinai Medical Center reserves the right to revise this publication and to make changes in content from time to time 
without obligation on the part of Cedars-Sinai Medical Center to provide notification of such revision or change. 

Copyright © 2013 Cedars-Sinai Medical Center 
Artificial Intelligence in Medicine (AIM) Program 
8700 Beverly Blvd 
Los Angeles, CA, 90048, USA 
Property of Cedars-Sinai Medical Center 

Prescription Device Statement  

Caution: Federal law restricts this device to sale by or on the order of a physician (or properly licensed practitioner).  

Disclaimer 

Neither Cedars-Sinai Medical Center, its parent, nor any of its worldwide affiliates shall be liable or obligated in any manner in 
respect of bodily injury and/or property damage from the use of the system/software if such is not in strict compliance with 
instructions and safety precautions contained in the relevant operating manuals and in all supplements thereto, in all product 
labels, and according to all terms of warranty and sale of the system, or if any change not authorized by Cedars-Sinai Medical 
Center is made to the software operating the system. 

Trademarks 

Cedars-Sinai, QGS and QPS are trademarks of Cedars-Sinai Medical Center.  

Adobe, the Adobe logo, Acrobat, the Acrobat logo, and PostScript are trademarks of Adobe Systems Incorporated or its 
subsidiaries and may be registered in certain jurisdictions. 

UNIX® is a registered trademark of The Open Group. 

Linux is a trademark of Linus Torvalds and may be registered in certain jurisdictions. 

Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or 
other countries. 

Other brand or product names are trademarks or registered trademarks of their respective holders. 
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CE Marking 

Cedars-Sinai Cardiac Suite is CE Marked to the Medical Device Directive 93/42/EEC. 

  0470 

 
Manufacturer: 
Cedars-Sinai Medical Center 
Artificial Intelligence in Medicine (AIM) Program 
8700 Beverly Blvd 
Los Angeles, CA 90048, USA 
 

 
European Authorized Representative: 

MediMark® Europe Sarl 

11, rue Emile Zola – BP 2332, 

38033 Grenoble Cedex 2  

FRANCE 
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User Assistance Information 
For assistance please visit our website or contact us via e-mail:  

[Website] www.csaim.com 

[E-mail] support@csaim.com 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

WARNING 
Do not install software applications not approved directly by your workstation vendor.  The system is 
only warranted and supported as configured and delivered.  Refer to the vendor documentation for 
detailed system requirements. 
 
Installation of Cedars-Sinai Cardiac Suite on vendor workstations is only to be performed by an 
authorized service engineer or applications specialist. 
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1. Introduction 

1.1. Indication for Use 
The Cedars-Sinai Medical Center (CSMC) Cardiac Suite of applications is intended to enable an 

automated display, review, and quantification of Nuclear Medicine Cardiology medical images and 

datasets. CSMC Cardiac Suite may be used in multiple settings including the hospital, clinic, doctors 

office, or remotely. The results provided should be reviewed by qualified healthcare professionals 

(e.g., radiologists, cardiologists, or general nuclear medicine physicians) trained in the use of 

medical imaging devices. 

1.2. Description of Device 
The Cedars-Sinai Cardiac Suite is a stand-alone software solution for Cardiac SPECT and PET imaging 

processing and review.  Cedars-Sinai Cardiac Suite (non-viewer) minimum system requirements 

include a computer with at least 1GB RAM, 50MB hard disk space for software installation, a display 

resolution at least 1024x768 with 16-bit color, a network adapter, a mouse (or other pointer device; 

trackpad, trackball, etc.) and one of the following operating systems: Windows XP, Windows Vista, 

Windows 7, Windows 8, Windows Server 2003, Windows Server 2008, Windows Server 2012, MAC 

OS X (10.6, 10.7 & 10.8) . The viewer component of the Cedars-Sinai Cardiac Suite minimum system 

requirements is iPad 2, iPad (3rd generation), iPad (4th generation) and iPad Mini.  CSMC Cardiac 

Suite operates on camera independent reconstructed SPECT and/or PET image files. 

CSMC Cardiac Suite will be marketed as a comprehensive application suite that includes QGS+QPS 

(Quantitative Gated SPECT + Quantitative Perfusion SPECT) in a single application (AutoQUANT) and 

CSImport applications. This allows automatic processing and review of quantitative and qualitative 

information generated by nuclear medicine studies. Purchasable options consist of Quantitative 

Blood Pool SPECT (QBS), QARG (for reporting purposes), Fusion (SPECT/CT/CTA and/or 

PET/CT/CTA), AutoRecon, Motion Correction (MOCO), Remote Viewer (Viewer) and QPET.  QPET 

also includes viability quantification and two additional databases (rubidium and ammonia) for 

processing PET studies.  

QPS+QGS is an application which combines both Quantitative Perfusion SPECT (QPS) and 

Quantitative Gate SPECT) into a common application.  Quantitative Perfusion SPECT (QPS) is an 

application designed for LV (Left Ventricle) and RV (Right Ventricle) extraction and analysis. QPS 

provides a tool to review and quantify perfusion Cardiac SPECT and PET data sets to determine the 

location, orientation, and anatomical extent of the left ventricle of the heart, to construct 3D 

contour maps of the heart, and to calculate the heart volume. Physicians use this information to 

assess the anatomical and physiological functionality of the heart and analyze the presence of 

myocardial defects through comprehensive imaging modalities. Stress-Rest Registration is a direct 

method for detecting changes between stress and rest images. It is a practical and fully automatic 

algorithm for quantification of stress-induced changed from paired stress and rest scans and does 
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not use protocol-specific databases. Prone-supine quantification allows quantification of perfusion 

on prone images as well as combined quantification of prone/supine datasets by applying heuristic 

rules, which allow automatic elimination of image artifacts based on the relative defect locations on 

prone and supine images. The shape index parameter defines 3D left ventricular (LV) geometry 

derived from LV contours in end systolic and end diastolic phases. QPS includes an algorithm for the 

quantification of myocardial perfusion, using normal limits created from studies of low-likelihood 

normal patients only. The algorithm has been validated in a large group of patients demonstrating 

equivalent diagnostic performance despite the use of simplified normal limits. The following 

databases are being provided (for male and female): Prone Stress MIBI, Rest MIBI, Rest MIBI AC 

(Attenuation Corrected), Rest Thallium, Stress MIBI, Stress MIBI AC, Stress Thallium. Optional 

normal limits databases offered are Rubidium for PET, Ammonia for PET. QPS provides the ability 

for user generated normal limits files using the simplified method. QPS also includes a variable, 

Total Perfusion Deficit (TPD), which combines defect extent and severity values.  The new quality 

control (QC) automatically detects quantitative segmentation failures. In the event of a failure a 

different algorithm is applied.  Quantitative Gated SPECT (QGS) is an application designed for LV 

(Left Ventricle) and RV (Right ventricle) extraction and analysis. QGS provides a tool to review and 

quantify function Cardiac SPECT and PET data sets to determine the location, orientation, and 

anatomical extent of the left ventricle of the heart, to construct 3D contour maps of the heart, and 

to calculate the heart volume (for the left ventricular wall). Physicians use this information to assess 

the anatomical and physiological functionality of the heart and analyze the presence of myocardial 

defects through comprehensive imaging modalities. A new Phase page included in QGS page gives 

access to phase information for gated datasets. A new technique to create cardiac "motion-frozen" 

perfusion or viability images, by warping ECG-gated images to the end-diastolic position has been 

added. Such "motion-frozen" perfusion and viability images have improved resolution and contrast 

by removing blurring effect caused by cardiac motion. The new quality control (QC) automatically 

detects quantitative segmentation failures. In the event of a failure a different algorithm is applied.  

QGS+QPS can also generate and display TID (Transient Ischemic Dilation) and LHR (Lung Heart Ratio 

or Lung Heart Counts).  A new group processing algorithm has been added which allows for 

simultaneously solving left ventricular geometry for all of the available datasets. It allows the 

algorithms, in regions where structure cannot be definitively determined for one or more of the 

datasets, to make decisions that exploit all the available information and that do not introduce 

arbitrary inter-study inconsistencies. 

Quantitative Blood Pool SPECT (QBS) is an optional application. QBS is an interactive standalone 

software application for the automatic segmentation and quantification of gated short axis blood 

pool (red blood cells, RBC) SPECT. The application can be used for automatic generation of left and 

right ventricular endocardial surfaces and valve planes from three-dimensional (3D) gated short axis 

blood pool images; automatic calculation of left and right ventricular volumes and ejection 

fractions; calculation and display of polar maps representing wall motion and parametric values 

(FFH amplitude and phase); two-dimensional (2D) image display using standard American College of 
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Cardiology (ACC) cardiac SPECT conventions; and 3D image display. It also provides the following 

functionalities: ability to combine isosurfaces extracted from the data with the calculated 

endocardial surfaces in various ways (endocardial borders displayed as wireframes, shaded 

surfaces, both, or parametric); ability to map parametric values (First Fourier Harmonic (FFH) 

amplitude and phase) on the surfaces; ability to display parametric images (FFH amplitude and 

phase) for gated planar, gated raw projections and gated short axis images; ability to display cine 

loops of the original images; ability to generate count-based quantitative values using the 

automatically- and semi automatically-computed surfaces as ROls and user-selectable thresholds; 

ability to generate and display phase histograms for FFH phase images and to display the mean and 

standard deviation of the peaks corresponding to atrial and ventricular voxels. After ventricular 

segmentation, a phase histogram for each ventricle is also computed and displayed; and ability to 

display normalized images for all gated images (i.e., images that do not exhibit count drop-off 

caused by arrhythmia). In addition, QBS supports manual identification of the left-ventricular (LV) 

region, to separate it from the right ventricle (RV) in cases where the automatic algorithm fails or 

returns unsatisfactory results; ability to generate filling rates from interpolated time-volume curves; 

and the ability to rotate, zoom, and cine surfaces. 

A nuclear image fusion package is available as an option to QGS+QPS for both SPECT/CT and PET/CT 

hybrid applications. The fusion option includes a page that allows for display of segmented and 

labeled coronary vessels with PET 3D data. Functionality includes orthogonal planes using alpha 

blending, roving window and synchronized cursor. It allows users to perform quality control of 

SPECT/CT/CTA or PET/CT/CTA alignment and has generic multimodality fusion capabilities. This 

feature provides display of fused images in a visual format. Additionally, included for PET analysis is 

the Hibernating Myocardium Assessment (mismatch and viability); this module allows quantitative 

assessment of "hibernating myocardium" by quantification of changes between PET perfusion and 

viability images in hypo-perfused area. Scar and Mismatch parameters are reported as a percentage 

of the Left Ventricle and are displayed in polar coordinates or a 3D surface display. A new 

registration algorithm has been added which automatically registers SPECT/PET with CTA/CT 

datasets.   

Quantitative PET (QPET) is an optional module which adds automatic segmentation, quantification 

and analysis of static and gated myocardial perfusion PET, with support for both short axis and 

transverse datasets.  The QPET module includes dynamic PET capabilities, such as calculation of 

absolute blood flow within the myocardium. 

CSImport is an application designed to import datasets from a variety of sources, store them in a 

local image database, and launch any number of applications that use this data for their processing 

purposes. CSI also provides a variety of data management tools, and includes a DICOM Store Service 

Class Provider (SCP) service that allows DICOM-compliant systems to push images to your PC for 

processing and review. 
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AutoRecon is a one-step application for automatic reconstruction and reorientation of raw 

tomographic data (raw projections), with an emphasis on cardiac images. The application offers a 

choice of filtering and reconstruction options (including iterative reconstruction) and automatic 

reorientation (>95%).  AutoRecon offers several automatic processing modules for single-photon 

emission computed tomography (SPECT) studies. Although it is mainly designed for cardiac data, 

many of its functionalities can be applied to other types of SPECT studies. AutoRecon provides 

automatic reorientation of three-dimensional, transaxial myocardial perfusion SPECT images. 

AutoRecon is comprised of four modules: reconstruct, reorient, motion and filter.  Each module has 

associated pages that present data and the controls necessary to perform the specific task for 

which the page has been designed. The program can be used interactively on one or more datasets 

or in batch mode to process data without further intervention from the user. If matching rest and 

stress datasets are provided, AutoRecon will automatically operate in dual mode. 

MoCo (Motion Correction) is an optional application for the automatic and manual correction of 

SPECT acquisition motion artifacts.  Pattern matching and segmentation algorithms are used in 

conjunction to minimize motion error metrics over the set of acquired projections; the resulting 

motion corrected projections are then presented to the operator for validation or modification.   

QARG (Quantitative Automatic Report Generator) is a tool that, together with the ARG server 

produces comprehensive nuclear cardiac reports.  QARG includes data collection utilities, data 

consistency checks, report generation, search utilities and several administrative tools. During the 

data collection process users are automatically prompted to resolve potential inconsistencies. Once 

the data acquisition is complete, the reports are generated. Reports not only contain derived 

values, but output clear sentences designed to send to the referring physician. QARG merges data 

from all sources to produce a single comprehensive report.  CT and Blood Pool reports are now 

available. 

The viewer application is an optional tool intended to enable the display and review of Nuclear 

Medicine Cardiology medical images and datasets. This application may be used in multiple settings 

including the hospital, clinic, doctors’ office, or other remote locations. The application enables 

clinicians the ability to review studies on a mobile platform giving them the flexibility to read 

studies without geographical & physical limitations.  The results provided should be reviewed by 

qualified healthcare professionals (e.g., radiologists, cardiologists, or general nuclear medicine 

physicians) trained in the use of medical imaging devices.  
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1.3. New Features 
There are many new features in this version of CSMC Cardiac Suite.  These are some of the most 

important. 

 CSImport has been completely overhauled with improved user interface and performance.  

Some of the new features include: 

o Support for SQL database backend. 

o User and site centric access control, similar to QARG. 

o User specific options for storing data privately or publically. 

o Enhanced task management system. 

o Deleted items management utility for recovering deleted items. 

o Enhanced logging for operations such as importing, replacing, deleting, etc. 

o Options for reconciling or linking studies. 

o Advanced filtering options that include options such as patient position (prone/supine/…), gating 

(static/gated/dynamic), patient state (rest/stress/…), etc. 

 

 

 QARG contains a significant number of enhancements and new features.  Some of the new 

features include: 

o Support for blood pool studies (includes integrated support for QBS), pyrophosphate studies and 

CTA studies. 

o Advanced appropriate use criteria engine based on ASNC guidelines. 

o Automated options for generating detailed administrative reports. 

o Advanced report distribution engine. 

o Simplified user interface and report templates. 

o Standard, IAC (formerly ICANL) compliant, 1 page report templates. 

o Support for opening multiple studies or reports. 

 

 Group processing / Reproducibility option for QGS+QPS, which allows for simultaneously 

solving left ventricular geometry for all of the available datasets. Previously all datasets 

were contoured independently; this change allows for a more consistent physiological 

shape for all images of the patient's study.  

 Multi-monitor (unlimited) display mode for QGS+QPS and QBS. 

 

1.4. Manual Conventions 
The following typographical conventions are followed throughout the manual: 

 User interface (UI) elements (menu items, buttons, etc…) are depicted in this style (bold, 

light-colored serif type). 

The paths to menu items and sub-items are abbreviated as Menu > Item or 
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Menu > Submenu > Item.  

Similarly, a tab Tab on a dialog opened by selecting a menu option Option may be 

referenced as Menu > Option > Tab. 

 User input, including single keys such as shortcuts, is depicted using this style (bold, 

bright-colored sans-serif type). 

 Code or information found in configuration files is depicted using this style (bold, 

colored fixed-width type). 

 Other items of interest, such as references to other sections, are depicted using this style 

(bold, italicized, colored sans-serif type). 

The following symbols are also used to draw attention to certain information: 

 

Information. The note describes something that may affect the behavior of the 
application but does not pose an inherent risk. 

 

Caution. Review this information carefully. Misuse of a feature may lead to unwanted 
consequences and possible data loss. 

 

 

1.5. General Warnings and Cautions 

 

 

Software is designed to manage and analyze data that contains sensitive patient 
information.  Oblige to all HIPAA standards in safeguarding all patient 
information and allow access to authorized users only.  It is recommended to 
create password protection where offered within the program or device on 
which the software is installed. 

 

 

Program is designed to automatically process data and generate quantification 
results, it is not meant to offer a standalone diagnosis.  A qualified physician’s 
assessment of the results is required.  

 
 

While every effort has been made to ensure the accuracy of the information in this manual, you 

may occasionally notice slight differences between screen captures and the actual software. 
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2. Setup Instructions 
This section summarizes the installation instructions and assumes you are familiar with various 

concepts such as using a CD and installing programs. For more detailed instructions (including 

screenshots) read the Installation section of the CSI Reference Manual. 

You will need: 

• A computer running one of the supported Operating Systems (OS) of Microsoft Windows or 

Macintosh OS X. 

• The installation CD-ROM disc or file (if software was obtained electronically). 

Do the following: 

1. Log into the system as a user with “Administrator” privileges. 

2. Insert the CD-ROM or double-click CSMC_Setup.exe. 

3. Wait for the auto-play application to start.  

4. When the setup program starts, go through all steps accepting the default values or check 

the boxes for the specific software options purchased.  

5. The setup program will automatically update the necessary registry keys if you have 

administrative privileges. 

6. When the setup program is finished, reboot the computer if necessary (as suggested by the 

setup program).  

7. Double-click on the "CSImport" icon shortcut on your desktop. 

8. Send the system identifier to your CSMC support representative for obtaining a license 

registration key. 

9. Enter the registration key in the licensing dialog. 

10. You’re done! The data browser CSI will now start and bring you to the main data browser 

screen. 
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3. Operating Instructions 
 

3.1. CSImport 
Cedars-Sinai Import (CSI) is primarily an image database front-end that is also commonly used for 

launching external applications. It is designed to allow the user to retrieve datasets from a variety of 

sources such as the Philips Pegasys, Jet Stream, and EBW workstations, FTP servers, and DICOM 

Query/Retrieve servers. CSI also provides a variety of data management tools, and includes a 

DICOM Store Service Class Provider (SCP) service that allows DICOM-compliant systems to push 

images to your PC for processing and review. Details of the DICOM interaction can be found in the 

DICOM Conformance Statement. 
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3.1.1. Initial setup 

CSImport controls data accessibility via 

user credentials.  The image data base 

maybe setup as a private or shared 

database.  When CSI is run for the first 

time, it allows the ability to select the type 

of database that is desired.   

Select standalone if you do not have 

multiple computers connecting to a 

central CSImport or ARG SQLSERVER 

database. 

 

Select Central Server if you have access to 

a CSI/ARG SERVER.  All users who have an 

account on the server will have access to 

this system.  Choose this option only if 

instructed by your system administrator. 

 

 

Once the system type selection is made, 

the next step is setting up admin user 

account.  All fields must be completed 

on this dialog before the setup process 

can be concluded.  This will be the 

administrative user account (username 

admin). 
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The next step is to create a 

standard user account.  User 

type choices are: Staff 

Physician, Clinical Fellow, 

Administrator, Technologist 

and System User.  All fields 

must be completed on this 

dialog before the setup process 

can be concluded. 

 

 

 

 

 

 

    

A confirmation dialog will 

summarize the information 

entered on the previous 

screen, verify the information 

for correctness and click Finish. 
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3.1.2. Launching an application 

You can select one or more folders that represents DICOM series, studies, or patients, or any other 

type of data organization (e.g., a folder that contains studies for multiple patients suffering from the 

same pathology), and launch the application with all datasets contained within the selected folders 

by clicking the toolbar button for that application (e.g., QGS+QPS, QBS, Arecon, etc).  

Note that having launched one application does not prevent you from going back to the data 

browser and launching another application, either for the same data or for a different selection. 

Data selection follows the same conventions as Windows Explorer: clicking an item selects it, 

clicking another item selects that item instead of the previous selection, and keys such as Shift and 

Ctrl can be used in conjunction with mouse clicks to extend or modify the selection, respectively. 

 

 

3.1.3. Importing data 

There are multiple options for importing images based on where the data is located.  For purposes 

of this example, let’s assume that the data resides on a locally accessible disk (i.e. a local hard disk, 

mapped drive from another computer, CD or DVD, portable USB drive, etc).   
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3.1.4. Importing data from a local disk 

This option should be used to import data that resides on a disk accessible through the computer’s 

file system. This includes data residing on: 

 hard disks; 

 CDs or DVDs; 

 flash drives; 

 Remote disks accessed by mapping a drive letter to a remote folder. 

The image below depicts a typical display when a folder has been opened and its contents are 

displayed.  Local disk files can be browsed by clicking Files on Disk from the Data Sources section 

and navigating to the location of the files using the windows file explorer like view. 

 

Note the folder selection control to the left (a path can also be typed directly in the text field at the 

top). To the right, files that are recognized as images are displayed. Enough information is displayed 

for each file to allow the selection of the appropriate image(s). 

There are two ways to import files: by selecting individual files, or by importing entire folders. 
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To import selected files, click, click-drag, or control-click files. Select the appropriate import options, 

and then click import. After the import process is complete, either navigate to another folder to 

import more files or click on local database option from Data Sources to go back to the original 

view. 

To import entire folders, select the folder and click import. If Do not recurse into sub-folders is 

checked from the Import Options dialog, only files inside the selected folders will be imported. If it 

is unchecked and if the selected folders contain sub-folders, all datasets within all sub-folders will 

be imported as well. 

 

The following import options are available: 

Make data private – this option can be checked 

to hide the imported data from other users. 

Recursive Import – this option can be checked if 

only data in the selected folders, not from their 

subfolders, should be imported. 

Tags – Options to add customized tags to the 

imported data at the patient or study level. 

 

 

 

3.1.5. Connectivity Configuration Assistant - AimConfig 

The AIM Auto-Configuration tool (“AimConfig”) is intended to simplify the configuration of 

computer systems in order to exchange information with a system that is running the Cedars-Sinai 

Cardiac Suite (“CSI system”).  This includes configuring remote systems to allow CSI system to query 

remote nodes and configuring DICOM nodes that will push data to Imhotep (the Cedars-Sinai 

DICOM Store SCP). 

The four supported remote system platforms for AimConfig are: 

 Philips JetStream 

 Philips Extended Brilliance Workspace 

 GE Xeleris 

 Siemens E.Soft 
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AimConfig is designed to enable the user to establish successful connectivity between the desired 

systems by following 3 key steps: 

1. Run the Connectivity Configuration Assistant wizard in CSI to write out the CSI system’s 

connectivity information to a removable USB storage device ("USB drive"). 

2. Take the USB drive to each applicable remote system that needs to be connected to CSI and 

run the AimConfig application directly from the USB drive. This step will configure the 

remote system to push to the CSI system and add a CSI DICOM node to its list. Additionally, 

it will also capture connectivity information about the remote system onto the USB drive. 

 

Note:  For connectivity configuration changes to take effect properly, each remote system 

should be restarted after completing step 2. 

 

3. Take the USB drive back to the CSI system and re-run the Connectivity Configuration 

Assistant wizard in CSI to complete the configuration of this system. This step will write 

connectivity information about each applicable remote system to CSI and configure them as 

individual DICOM nodes. 

 

Below is a detailed step-by-step example of using the auto-configuration utility. 

Step 1:  System - CSI 

1. Initiate the AimConfig wizard by selecting Options > Configuration Assistant… as shown below.  
This will open the introduction screen of the utility in a separate window. 
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2. Click Next > to proceed to the next screen, which allows you to select a removable USB drive to 
write CSI connectivity information.  Ensure that step 1 radio button is selected on this screen 
before proceeding. 

 
 

3. Click Next > to write the CSI information to the USB drive.  Once the utility has successfully 
written the CSI information, it will display a confirmation screen as seen below. 
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Step 2:  System - Remote 

1. After logging in to the remote system to be configured (e.g., Philips JetStream or GE Xeleris) 
insert the USB drive and navigate to <drive>\CSMC\aimconfig, and double-click aimconfig.exe 
to start the program.  Where <drive> is the letter of your USB drive. 

 
 
 

2. Click Next > on the wizard introduction screen and select the appropriate options on the 
Configuration Information screen as shown below (the options selected by default are most 
likely correct). 
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In the above example, both options are checked to indicate that: 

 This Philips Extended Brilliance Workspace system will be configured to push to the CSI 
system’s AE Title “STORESCP” on port 104 

 Information will be written back to the USB drive to allow the CSI system to query this 
system using DICOM Query/Retrieve. 

 
3. Click Next > to continue to the DICOM Nodes screen that will allow you to test the connection 

and also edit the display name of the node. 

 
 

4. Click Next > to continue to the confirmation page that will allow you to verify your selections 
before committing.   The Commit button will conclude the configuration for this remote system. 
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 CAUTION:  The new configuration settings may not take effect properly until the  

        remote system is restarted.  

 

5. A configuration summary page will be displayed as shown below.  Click Details to display the 
specific actions that were conducted by AimConfig.  Clicking the Save Log File... allows you to 
save a log file that contains details of the changes made to the remote system. 
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Step 3:  System - Return to CSI system 

1. Re-launch the Auto-Configuration wizard by selecting Options > Configuration Assistant as 
before.  This will open the utility in a separate window that will display the introduction screen 
with a summary of the connectivity process. 

 

2. Click Next > to proceed to the next screen, which allows you to select a removable USB drive to 
write CSI connectivity information.  This time select step 3 radio button before proceeding. 

 
 

3. Click Next > to proceed.  The utility will automatically detect applicable remote system(s) and 
display them on this page.  Select the desired systems and click Commit to add the selected 
remote systems to CSI.  A confirmation screen will be displayed once the systems are 
successfully added. 
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4. The new remote system node will be added to CSI and can be edited or removed from the 
Options > Manage Remote System... menu option. 

  

 

AimConfig Troubleshooting 

Problem 
I cannot locate CSMC\aimconfig folder on the USB drive. 
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Solution 

Re-run the Auto-Configuration wizard in CSI and ensure that the correct USB drive is selected from 

the drop-down list on the second page of the wizard. 

 

Problem 
Auto-Configuration wizard is unable to write to the selected USB drive and displays the message 

shown below. 

 
 

 

Solution 

Ensure that there is at least 10MB of free space present on the USB drive.  You can free up 

additional space on the drive by deleting content no longer needed. 

 

Problem 

Network test fails on remote system as shown below. 

 
 

Solution 
There are number of issues that can cause the network test to fail. 

 Check to make sure the Port and Server IP Address information is accurate for the CSI 

system.  If necessary, edit this information and click Test to re-run the network test. 
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 Check the Windows firewall settings on the CSI system to make sure the DICOM Store SCP 

Service is allowed to listen on a network port.  The service's executable is called 

imhotep.exe and should be allowed network adapter access. 

 Make sure that there are no other DICOM Services running on the CSI system using the 

same port number as CSI as this may cause the services to compete with each other. 

 Check with the site administrator to make sure both systems are on the same network and 

are able to communicate bi-directionally. 

 

Problem 

Remote system is not able to push data or CSI is not able to Query data from a remote system after 

a few days of establishing successful connectivity. 

 

Solution 

Check with the site administrator to make sure that both systems are on a static or reserved IP 
address.  Once this is verified, follow the step-by-step instructions to re-establish connectivity. 

3.1.6. Importing data from a remote system 

The four types of supported remote systems are: 

 Philips (ADAC) Pegasys 

 Philips (Marconi) Odyssey 

 FTP server 

 DICOM Query/Retrieve server/Store Server 

Creating remote system configurations 

Each remote system must be configured in CSI before it can be contacted to import/export data. 

DICOM Q/R servers also often require server-side configuration. This will generally need to be 

performed by the PACS administrator (for Picture Archiving and Communication Systems) or by 

technical support personnel (for non-PACS imaging workstations such as acquisition systems). 

The beginning of the procedure for creating a new configuration for a remote system is the same 

for all system types:  

 Select Options > Manage Remote Systems…  

 Click Add… in the Remote Computer Systems window 

The next step is to set basic information for the system in the Remote Computer Systems window: 

 Select the “Remote Computer Type”  

 Enter a “Display Name” that will be used throughout the program to identify the system 
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 Enter the IP address of the remote system. It is recommended to use IP addresses instead of 

names, unless the remote system’s address is likely to change due to dynamic address 

allocation 

 

Once the remote computer type has been set, the lower portion of the dialog will update to reflect 

the specific settings required by that type of system. 

In general: 

 For Pegasys systems no changes are required; 

 
 For Odyssey systems, only the data directories need to be updated (usually one or more of 

the form “/imgX” where “X” is a number); 

 
 

 For FTP servers, the appropriate account information (username and password) must be 

entered. “Port” and “Initial Directory” can often be left to default values.  
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 For DICOM Query/Retrieve/Store servers, the AE titles, port number, and query root level 

need to be set to values as prescribed by the remote system’s administrator. Setting the 

system’s “Vendor” type will in some cases allow CSI to restrict itself to operations that are 

known to function for those systems (not all DICOM systems offer the same level of 

functionality). 

 

Default values can be reset by clicking Reset, and basic connectivity tests can be run by clicking 

Test. 

Click OK to accept the settings when the configuration information of the new remote system is 

satisfactory. The new system will appear in the remote computer list, where it can be used to 

retrieve data. 

Philips Pegasys 

To import data from a Pegasys system, click the name of the system from the remote systems list. 

This will bring up the Pegasys dialog and start the connection to retrieve the study list.  
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To import entire studies, select one or more desired studies (click, click-drag or control-click in the 

list), set the import options and click Import….  

When done importing, either select more datasets, return to the studies selection page by clicking 

on Local Database.  

Philips Odyssey 

Odyssey connectivity is very similar to Pegasys connectivity. Only the information is presented 

slightly differently, reflecting the naming conventions and fields available on Philips Odyssey 

systems. 

 

FTP Server 

The main downside of using a FTP server to retrieve data is that images can only be selected by file 

name, without added information such as patient name, study description, etc. A typical file list is 

shown in the figure below. 
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To navigate to another folder, either type the path in the Directory box or double-click folder names 

in the list (including the special “<UP>” folder to navigate to the parent directory). 

By default, all datasets are selected. Use control-click to remove individual items from the selection. 

When ready, click Import to import the selected datasets.   

DICOM Query/Retrieve Server 

Importing data from a DICOM Q/R/S server requires more configuration than any other type of 

remote system, but it is the only method to gain access to PACS and other DICOM-based systems. 

Once the system has been configured and a connection established, the following dialog is 

presented: 
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Because PACS systems often store very large amounts of data, no query is sent to the server until 

Query is pressed. This allows for the selection of a study filter to limit the number of results.  

For a more detailed explanation of the other capabilities of the DICOM import dialog, please consult 

the Reference Manual. 

Pushing DICOM datasets from a remote system 

In addition to the ability to pull data from a variety of sources, it is also possible to push images 

from other DICOM-compliant systems to the system running CSI. CSI includes a Windows service 

called “Cedars-Sinai DICOM Store SCP” that listens for incoming connections. Most modern imaging 

platforms can connect to this service and send images which are then stored locally on your PC and 

inserted in the local image database. 

To use this mechanism, you need to configure the DICOM Store SCP service with the appropriate 

parameters. The configuration dialog that is shown below can be launched from Options > DICOM 

Configuration. 
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To configure the DICOM Store SCP, follow these steps: 

1. Go to Options > DICOM Configuration 

2. Choose an application entity title (AE Title) for your computer.  AE Titles are managed by the 

site manager and can be accessed by clicking Manage Sites…. 

3. Choose a port number on which source systems will contact your computer (default: 104, 

other recommended setting: 1104). 

4. To limit access to selected remote systems, click Edit Restrictions… and enter the 

acceptable AE title information. By default the system accepts connections from all remote 

systems. 

5. Leave the rest of the options unchanged. 

6. Click OK to apply the changes and restart the service. 

You will now need to configure any source system with the appropriate settings to be able to send 

data. In general, configuration of the source systems will require the following information:  

• The IP address of your computer 

• The AE Title selected in step 3 above 

• The port number selected in step 4 above 

DICOM systems usually have the ability to perform a few connectivity tests (often called “echo” in 

reference to the DICOM C-ECHO message) to ensure the parameters are correctly configured. These 

tests should succeed if the DICOM Store SCP service is running on your system. 

Users on the remote systems can then select data and send it to your PC. The data should appear in 

the selected location. It may be necessary to refresh the list and/or modify data filters to see the 
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data. For instance, if you have selected to view only today’s studies and the study sent from the 

source system was acquired yesterday, it won’t show up in your list until you remove the date filter. 
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4. Quantitative SPECT/PET Applications - QPS (Perfusion) + QGS (Gated) 
The workflow is intentionally modeless.  As such, no particular processing sequence is dictated to 

the user.  A typical sequence might proceed as follows:  

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Load Datasets 

Repeat 

Reconstruction Raw Page 

Is there motion or 

incorrect acquisition (i.e. 

LV/RV is clipped) 

Yes 

No 

Slice Page 

Manual (Page) 

Processing 
No 

Splash Page 
Review rest/stress 

slices 

Review regional perfusion 

and function scores; 

determine manually or 

auto generated 

Surface Page 
Review surfaces 

Views Page 
Review views 

Optional 

Results Page 
Review Polar Maps, quantification 

data and time-volume curve 

(Phase page if available) 

 

Integrated 
ARG 

Report 
(If available) 

 

Are contours incorrect?  

Yes 
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4.1. Language Selection 
CSMC Cardiac Suite supports user interface localization.  Some languages may not be available on 

all platforms. To select a language open Defaults dialog, click the Language tab and select the 

desired language from the drop-down menu.  

The new language setting will take effect when the program is restarted. Note that this setting 

affects all CSMC Cardiac Suite applications. 

Changing the language setting within CSMC Cardiac Suite will not affect the language settings of the 

operating system or any other applications not part of the suite. 

 

4.2. File Selection (using patient example) 

QGS+QPS is able to quantify global and regional parameters of perfusion and function using one or 

more, gated or summed short axis data set.  For perfusion analysis, typically two data sets - 

stress/rest, stress/redistribution, rest/redistribution, etc. are used.  If possible, it is also advisable to 

select the related projection data set(s), so as to be able to assess acquisition artifacts at the earliest 

possible stage in the processing/analysis chain.  For the purposes of this example, we’ll assume to 

have selected the following files for the patient ABNORMAL STUDY: 

Study   Dataset    Description 

STRESS MIBI  Raw Summed Stress  (Summed stress projection image set) 

STRESS MIBI  Raw Gated Stress  (Gated stress projection image set) 

STRESS MIBI  SA Gated Stress  (Gated stress short axis image set) 

STRESS MIBI  SA Summed Stress  (Summed stress short axis image set) 

REST THALLIUM Raw Summed Rest  (Summed rest projection image set) 

REST THALLIUM Raw Gated Rest  (Summed rest projection image set) 

REST THALLIUM SA Gated Rest   (Gated rest short axis image set) 

REST THALLIUM SA Summed Rest  (Summed rest short axis image set) 

 

4.3. Launching 
Launching QGS+QPS in its standard configuration will bring up the Main screen as shown below 

with the Raw page indicator and the Label toggle highlighted. A representative projection image 

from the Raw Summed Stress dataset is shown, with the number to its left showing its order in the 

dataset.  Left-clicking on Label toggles that number on and off.  Left-clicking on and dragging the 

vertical black stripe rightmost in the scale will “saturate” the scale and make the LV visible in cases 

where strong extra cardiac activity exists. 
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The name of the Folder (generally, a patient name) and that of the projection data set are displayed 

in the horizontal section that also contains the data set selector, the data set editor and the color 

scale. 

 

Left-clicking on the data set selector will bring up a pull-down menu listing all selected data sets as 

seen below, from which any projection data set can be chosen and displayed. 

 

 

 

Main screen 

toolbar 

     Folder/Data 

selector with color             

scale 



 
41 

Finally, the two projection datasets (or more, when applicable) can be displayed side-by-side by 

left-clicking Multiple on the page control bar.  While the color scale still acts on both images, an 

individual color scale is also provided underneath each image.  The number of controls on the page 

control bar is specific to the page selected on the Main screen toolbar. 

 

 

4.4. Reviewing the Rotating Projection Images 
Clicking Lines toggle brings up two horizontal lines that should be manually positioned so that they 

tightly straddle the LV shown below. A continuous loop cine display of the projection data sets can 

then be started by clicking Spin (0 to 360 degrees continuous rotation). Clicking Rock toggle (in 

addition to the Spin toggle) will display an alternating cine (0 to 180 degrees and 180 to 0 degrees 

rotation). The cine speed can be adjusted by clicking the ◄ ► symbols on the right side of the Rate 

label. Any sudden movement of the LV’s perceived boundaries towards or away from the lines 

should be noted, as should a uniform upward drift (upward creep of the heart, often associated 

with the diaphragm’s return to its normal position soon after exercise). With dual detector cameras 

in the 90 degree configuration, upward creep may produce a sudden “jump” in correspondence of 

the middle of the projection data set, as can detector misalignment. Major motion may affect the 

quantitative parameters; if such motion is detected, it would be prudent to repeat the acquisition. 
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In addition to patient or organ motion, flickering (sudden variations in brightness between adjacent 

projections) can be assessed by reviewing the projections cine. Flickering is often an indication of 

gating errors, which are reflected in the ungated projection images when the latter are built 

through summation of the gated projection datasets. 
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To generate a “movie” file of the raw data, click on the Movie button located on the global bar at 

the top right of the page to bring up the “movie” dialog box. Under the File tab page enter an 

appropriate path and file name for the newly created movie (AVI) file. Click OK. 
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4.5. Processing the Images 
Clicking on the Slice page indicator will highlight it and advance QGS+QPS to the Slice page view 

shown below. As a result, the SA Stress Gated data set or the Short Axis (SA) data set will be 

automatically selected and displayed. Five 2D images or “slices” are presented in standard ACC 

orientation, i.e., left to right = apex to base for three short axis images (top row), with the bottom 

row consisting of a horizontal and a vertical long axis image. 

Clicking the Process button will automatically apply the applicable algorithms to the data, 

segmenting the LV, calculating the endocardial and epicardial 3D surfaces and the valve plane, and 

determining all the global and regional quantitative cardiac parameters. The intersection of the 3D 

surfaces and the valve plane in the 2D slices planes are displayed as “contours” overlaid onto the 

five slices, which are now representative of equally spaced (short axis images) or mid-ventricular 

(long axis images) portions of the LV.  
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Moreover, all quantitative parameter fields in the right portion of the screen should now be filled 

with numeric values, in addition to the creation of time-volume and filling curves (for gated short 

axis datasets). We’ll examine and discuss the quantitative measurements in more detail later. 

 

 

4.5.1. Group Processing 

Group processing allows for simultaneously solving left ventricular geometry for all of the available 

datasets. It allows the algorithms, in regions where structure cannot be definitively determined for 

one or more of the datasets, to make decisions that exploit all the available information and that do 

not introduce arbitrary inter-study inconsistencies.  When Group is ON, datasets belonging to the 

same patient are processed as a “pair” (or, if more than two studies are involved, as a “group”). 

4.5.2. Checking the contours 

The location of the five slices displayed can be interactively adjusted by moving their corresponding 

slice reference lines in orthogonal views; however, in most patient studies this will not be 

necessary. Both the stress and the rest short axis datasets can be visualized by clicking the 2 (dual) 

buttons, which also splits the display in two as shown below. The stress images are displayed on the 

left half and the rest images on the right half of the display. 
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At this point, a visual check for obvious inaccuracies in the way the contours follow the LV must be 

performed. This will likely involve clicking the Contours toggle on and off, and possibly setting the 

images in motion (cine) by clicking the Gate toggle. Most major inaccuracies are due to the 

presence of extra cardiac activity, and will be immediately apparent from the display as seen below. 

In particular, one would expect to see the contours centered on a structure other than the LV, or 

see the contours “pulled away” from the LV to follow closely adjacent activity, especially in the 

inferior wall region. Both of these occurrences are extremely infrequent (0-5% in the published 

literature), and can be readily dealt with using the “Manual” option.  

 CAUTION:  If a failure rate higher than 10% consistently occurs, there may be a 

systematic problem with the way the data is acquired, patient positioning (too high/too low) 

or other errors 
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4.6. Modifying the Contours (Manual Page) 

Clicking the Manual toggle will bring up a modified version of the Slice page, with masking graphics 

superimposed upon the slices. It is possible to modify the shape and position of the masking 

graphics by left-clicking and dragging the masking graphic handles, small squares placed at various 

points on the masking graphics shown below. The mask should be shaped and positioned so that it 

encompasses the LV and excludes all extra cardiac activity. Before doing so, it may be advisable to 

toggle the incorrect contours off by clicking the Contours button. Clicking the Mask toggle and 

clicking the Process button will force the automatic algorithm to operate on the portion of the 3D 

image inside the mask, and new contours plus new quantitative measurements will be generated 

and displayed. 
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Note that the segment positioned on the LV’s long axis serves only as a reference. In cases where 

simple masking has not produced satisfactory contours as show below, one has the option of 

setting two exact locations through which the apical and basal portion of the contours must pass; 

this is done by clicking the Constrain toggle to highlight it, then clicking again on the Process 

button.  

 CAUTION: The “Constrain” option should not be used unless absolutely necessary, as it 

can greatly affect the reproducibility of the quantitative measurements. Please make sure the 

Constrain button is NOT highlighted when starting the masking process in the Manual page. 

One instance in which Constrain is used is when the valve plane is incorrectly identified and 

the stress and/or rest contours clearly exceed its location. This will typically result in a “ring” 

of artifactual hypoperfusion at the periphery of the perfusion polar map(s), not associated 

with a standard coronary territory. 
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4.7. Reviewing Gated SPECT images on the Slice page 
An initial visual assessment of LV function can be performed by left-clicking the Gate toggle to 

display cine of the five slices while clicking the Contours toggle on and off.  The cine speed can be 

adjusted by clicking the ◄ ► symbols on the right side of Rate.  Moreover, a temporal and a spatial 

smoothing filter can be applied to the images by left-clicking the Blur and Smear toggles, 

respectively.  This is especially useful to reduce statistical noise in low-counts images for visual 

assessment, and it will not affect the quantitative results.  

Note: The “Blur” and “Smear” functions only affect image display.  The QGS algorithms operate on 

the original, unsmoothed data regardless of Blur and Smear settings. 

INFORMATION: At Cedars-Sinai Medical Center (CSMC), a gray or thermal scale is typically used 

to assess motion, and a 10-point scale (Step10) is used to assess thickening.  A comprehensive 

description of the CSMC segmental scoring method can be found in “Berman D, Germano G. An 

approach to the interpretation and reporting of gated myocardial perfusion SPECT. In: G Germano 

and D Berman, eds. Clinical gated cardiac SPECT. Futura Publishing Company, Armonk; 1999:147-

182.”  Essentially, images are scored based on a 20 or 17 segment model and a categorical scale of 

0-5 (motion) or 0-3 (thickening).   
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4.8. Reviewing Gated or Summed (un-gated) SPECT Images on the Splash page 

Although the Slice page can be useful to make a quick initial determination of the presence and 

location of perfusion abnormalities, accurate perfusion assessment must precede from the entire 

short axis datasets. Clicking on the Splash page indicator will bring up all the available short axis 

images, which (if the 2 button is on) will be displayed in interleaved fashion for the stress and the 

rest studies as show below. In essence, the first dataset to appear in the Info box will correspond to 

rows 1, 3, 5 and 7 of the display, the second dataset to rows 2, 4, 6 and 8. Stress and rest images are 

automatically chosen, and ought to be well aligned; to manual shifting of a dataset by one or more 

slice(s) can be achieved by clicking and dragging the appropriate scrollbars to the right of the 

images.  Images (gated only) can be viewed simultaneously as cine by clicking the Gate toggle.   

A spatial smoothing filter can be applied to the images by turning on the Smear toggle on the page 

control bar. This is especially useful to reduce statistical noise in low-counts images for visual 

assessment, and it will not affect the quantitative results.  

Clicking on the dataset selector on the Splash page will bring up all the available short axis images.  

A spatial and/or temporal smoothing filter can be applied to the images by clicking the Smear and 

Blur (gated datasets only) toggles respectively.  This is especially useful to reduce statistical noise in 

low-counts images for visual assessment, and it will not affect the quantitative results. 
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Optionally, key slices may be “blown up” for further review. This is achieved by right-clicking on the 

desired images to select/deselect them (the corners of the selected items are highlighted in blue), 

then left-clicking on the Popout toggle on the page control bar. To de-select all the selected slices 

click Clear. The images below show four short axis, horizontal and vertical long axis images for each 

of the stress and rest data sets that can be displayed using the Popout toggle in the Splash page. 

 

INFORMATION: At Cedars-Sinai Medical Center (CSMC), a gray or thermal scale is typically 

used to assess perfusion. A comprehensive description of the CSMC segmental scoring method 

can be found in “Berman D, Germano G. An approach to the interpretation and reporting of 

gated myocardial perfusion SPECT. In: G Germano and D Berman, eds. Clinical gated cardiac 

SPECT. Futura Publishing Company, Armonk; 1999:147-182.“. Essentially, images are scored 

based on a 20 or 17 segment model and a categorical scale of 0-4 (0=normal to 4=absent 

perfusion).  
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4.8.1. Using the Score Box 

Clicking on the Score toggle will bring up the Score Box with its 20-segment or 17-segment polar 

maps with segment demarcation outlines for the stress, rest and difference portion of the study, 

shown below is a 20 segment score example. Each ring in these “categorical polar maps” is related 

to the displayed images as follows: apex to base = inner to outer rings.  

 The display scheme aims at making it easier for the physician to identify the 20 (or 17) segments for 

which perfusion must be scored. Selecting the Segments option from the Grid pull-down menu on 

the page control bar will overlay demarcations onto the stress and rest images, clarifying which 

portion of which slice belongs to which segment. Alternating between the Segments and None 

options of the Grid pull-down menu facilitates the visual assessment of segmental scores, which can 

then be entered in the Score box to override automatic scoring, if so desired.  

A universal set of normal limits is applied to all gated short axis datasets to automatically calculate 

motion and thickening scores for all segments, as well as the summed motion and thickening scores 

(SMS and STS), the percent summed motion and thickening scores (SM% and ST%) and the extent of 

motion and thickening abnormality (Mot Ext and Th Ext) expressed both as area in cm2, and as a 

percent of the mid-myocardial surface area.  If any of the segmental scores is deemed inaccurate by 

the reviewing clinician, he/she can increase it or decrease it by left or right clicking on its numeric 

value in the box. SMS, STS, SM% and ST% will adjust automatically. 
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If the appropriate normal limits are preset for this patient, the program will automatically calculate 

perfusion scores for all segments, as well as the summed stress, rest and difference scores (SSS, SRS 

and SDS) and the corresponding summed percent scores (SS%, SR% and SD%) and the extent of 

perfusion abnormality. Otherwise, the normal limits database to apply to the dataset will have to be 

selected by clicking on the Edit… button, located next to the dataset selector, and selecting the 

appropriate limits file from the dropdown menu. The user selects one of the displayed normal limits 

selections in the dialog window and clicks OK. If any of the segmental scores is deemed inaccurate 

by the reviewing clinician, he/she can increase it or decrease it by left or right clicking on its numeric 

value on the respective score polar map. SSS, SRS, SDS, SS%, SR%, and SD% will adjust 

automatically.  

Note: The summed percent scores represent the summed scores normalized to the worst 

possible score obtainable in the model chosen (i.e., 80 for the 5-point, 20-segment model and 68 

for the 5-point, 17-segment model), as described in Berman et al., JACC 2003;41(6):445A. 

 

 
 

Scoring is further enhanced by the color coding of 
segments based on the coronary vessels supplying 
that segment. The Tan colored segments are 
assigned to the LAD, Green to the LCX, and Blue to 
the RCA. By default, the application will attempt to 
choose the coronary vessel based on the visual 
scores. This can be overwritten by right-clicking on 
a segment and selecting the appropriate vessel 
from the list of vessels. In some cases it is unclear 
to which vessel the defect belongs. When this 
occurs, select the abnormal segment in question 

and choose a combination of vessels. The Auto 

button will load the automatically generated 
scores.  
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4.9. Reviewing SPECT Images in the Surface Page 

Clicking on the Surface page indicator will bring up the Surface page shown below, a parametric 

representation of the LV, consisting of a wireframe surface (epicardium) and a shaded surface 

(endocardium). This type of display is not as useful for perfusion as it is for gated SPECT data, but 

can nevertheless aid in assessing LV size and shape. Clicking Gate allows cine display to follow the 

3D endocardium and epicardium movement throughout the cardiac cycle, while clicking and 

dragging on the image will interactively and in real time position it to the observer’s liking.   

 

While myocardial thickening can be conceivably assessed from the epi-/endocardial display, it is 

easier to assess motion from a display containing the endocardium as well as its position at end-

diastole. This is achieved by selecting the Inner option from the Surface pull-down menu, and 

clicking ED on the page control bar to highlight it.  With this type of display and Gate toggle on, a 

good proxy for regional motion is how well the endocardium pulls away from its fixed position at 

end-diastole.  It is a good idea to display all three surfaces by selecting Both in the Surface pull-

down menu.  
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For function evaluation, the endocardial surface does not have counts mapped onto it, because it 

would make it harder to evaluate regional function in patients with large perfusion defects.  If one 

wants to visualize the evolution of perfusion during the cardiac cycle, selecting the Counts option 

from the Surface pull-down menu will display the mid-myocardial surface with maximal counts 

mapped onto it. 

Similarly, for perfusion evaluation, the endocardial surface does not have counts mapped onto it, 

because it would make it harder to evaluate LV size and shape in patients with large perfusion 

defects. If one wants to visualize 3D perfusion, selecting the Function option from the Surface pull-

down menu will display the mid-myocardial surface with maximal counts mapped onto it. 
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4.10. Reviewing gated SPECT images on the Views page 

Clicking on the Views page indicator will bring up the Views page shown below, with six 3D 

viewports very similar to that in the Surface page. The main purpose of this page is to allow full 

coverage of the LV (albeit with smaller images compared to the one in the Surface page), and to 

facilitate comparison of stress and rest images by manipulating them in lockstep through left-

clicking and dragging. Again, selecting the Function option from the Surface pull-down menu is 

recommended if perfusion needs to be assessed.  For gated SA datasets the top row represents the 

end-diastolic views of the RAO, LAO and inferior orientations.  The bottom row represents the same 

views and surfaces at end-systole. The images can be viewed as a cine display of the cardiac cycle by 

clicking the Gate toggle.  If more than one dataset is selected, three orientations per dataset will be 

displayed and cined, with each column of images manipulable in lockstep by left-clicking and 

dragging. 
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4.11. Putting it All Together: the QPS Results Page 

Clicking the QPS button in will bring up the QPS Results page, which aims at presenting, in synthetic 

format, all information related to the perfusion SPECT study for the patient. When available, two 

datasets are always displayed on the Results page (1, 3, and 4 display options are inactive). Clicking 

the Score toggle will replace the score box with either a table showing the amount of stress and rest 

defect extent and TPD as well as defect reversibility (Graph toggle off), or a bar graph showing 

percent stress defect extent and reversibility (Graph toggle on). If a screen capture is taken of this 

page with the Contours toggle off, the Smear toggle on and the Extent option selected from the 

Function pull-down menu, it would represent a good image to send the referring physician.  The 

following rule is applied to all pixel based scores (TPD, extent and defect) and segment based scores 

(visual scores): whenever rest scores contain values that are higher on rest than on stress (when 

comparing stress/rest pair pixel by pixel or segment by segment); in these situations the rest 

segment or pixel will be assigned the stress score values. 

 

4.11.1. Assessing the Polar Maps 

The results page provides three perfusion polar maps and three 3D parametric surfaces (stress, rest 

and reversibility). The Function pull-down menu contains the options Raw, Severity, and Extent, all 
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of which apply to both 2D and 3D displays. A grid of 20 or 17 segments (Segments), 3 vascular 

territories (Vessels) or 5 regions (Walls) can be overlaid onto all polar maps and surfaces from the 

Grid pull-down menu. For polar maps, the numbers associated with the overlay represent the 

average value of the parameter measured by each map within the segment, territory or region in 

which they lie. Both stress and rest perfusion values are normalized to 100. 

 

4.12. Putting it all together: the QGS Results page 

Clicking the QGS button will bring up the QGS Results page shown below, which aims at presenting, 

in synthetic format, all information related to the gated SPECT study in this patient.  QGS Results 

page only supports single dataset mode (the 2, 3 and 4 display mode buttons are inactive).  Both 

the end-diastolic and end-systolic representative short axis slices and 3-D surfaces will be displayed 

and the latter can be cined by clicking Gate.  Clicking the Score toggle off will replace the score box 

with a graph showing the time-volume curve (in black) and its derivative (filling curve), from which 

diastolic parameters are computed.  The time-volume curve should be used to evaluate the 

existence of gating errors.  If a screen capture is taken of this page with the Contours toggle off, the 

Blur and Smear toggles on and the Extent option selected from the Function pull-down menu, it 

would represent a good image to send the referring physician.   
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4.12.1. Assessing the time-volume curve 

A valid time-volume curve would be expected to have its minimum (end-systole) at frame 3 or 4, 

and its maximum (end-diastole) at frame 1 or 8 of a 8-frame gated acquisition. For a 16-frame gated 

acquisition, the minimum (end-systole) would be expected to be at frame 7 or 8 and its maximum 

(end-diastole) at frame 1 or 16. If major deviations from this expected behavior occur, the prudent 

assumption is that the gating was unsuccessful and the study needs to be repeated. Two examples 

of invalid time-volume curves are shown below. 

It should be noted that any errors in the time-volume curve (gating errors) will be propagated to the 

filling curve, since the filling curve is the first derivative of the time-volume curve. 

Note: In the time-volume curve graph, the volumetric value for interval 1 is also “appended” to the 

curve after interval 8 or 16, respectively, for 8-frame and 16-frame gated acquisitions. 
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4.12.2. Assessing the Polar Maps 

The QGS Results page provides two perfusion polar maps (at end-diastole and end-systole) and two 

function polar maps (regional motion and thickening). The Function pull-down menu contains the 

options Raw, Extent and Severity, all of which apply only to the function polar maps. Of those, only 

Raw is meaningful in the absence of motion/thickening normal limits. A grid of 20 or 17 segments 

(Segments), 3 vascular territories (Vessels) or 4 regions (Walls) can be overlaid onto all polar maps 

from the Grid pull-down menu: in every case, the numbers associated with the overlay represent 

the average value of the parameter measured by each map within the segment, territory or region 

in which they lie. 

Mapping of the endocardial motion in the motion polar map follows a linear model from 0 mm to 

10 mm. Motion greater than 10 mm is assumed to be = 10 mm (the scale "saturates" at 10 mm), 

while motion <0 mm (dyskinesia) is assumed to be = 0 mm. Likewise, thickening greater than 100% 

is assumed to be = 100% (the scale "saturates" at 100%), while thickening <0% (paradoxical 

thinning) is assumed to be = 0% in the thickening polar map. Unlike the motion map, which is 

"absolute" (millimeters), the thickening map is "relative" (thickness increase from end-diastole to 

end-systole). 

 CAUTION: While the presence of perfusion defects can be reasonably well assessed by 

“eyeballing” the perfusion polar maps, the same is not true of the motion and thickening 

maps! Indeed, it is well known that, even in normal patients, the septum typically moves less 

than the lateral wall (resulting in a “dark” area in the motion map), and the apex thickens 

more than the base (resulting in the “egg sunny-side-up” look of the thickening map). 

Function polar maps are best assessed by choosing the Extent option in the Function pull-

down menu, which will black-out abnormal areas. 

4.12.3. Pixel (Voxel) Size 

Area and volume measurements can be hampered by incorrect listing of the pixel size in the image 

header. This is usually not a problem with the LVEF, which is derived from a ratio of volumes.  



 
61 

Similarly, perfusion measurements such as the absolute area of perfusion defects (but not the 

measurements of defects area as a percent of that of the LV!) can be hampered by incorrect listing 

of the pixel size in the image. Pixel size is usually automatically calculated by modern cameras, 

based on knowledge of field of view and zoom information. However, older cameras or "hybrid" 

systems (where one manufacturer's camera is interfaced to another manufacturer's computer) may 

not be set up to transfer pixel size information from the gantry, or may take a "standard" size (i.e., 1 

cm) as default. In these cases, a correction factor should be manually calculated by imaging a 

known pattern (for example, two line sources separated by an exact distance), and counting the 

number of pixels between the lines' centroids in the reconstructed transaxial image. Key portions of 

an image header (including the pixel or voxel dimensions) can be viewed by selecting the More 

page.  

 CAUTION: One should be particularly wary of pixel sizes listed in the More page as 

integer numbers (0 and 1 being frequent occurrences), since they often indicate a transfer 

problem.  

 

4.13. Phase Analysis 
To view global and regional phase information for gated studies, click the Phase page button. Global 

statistics will be displayed if the Grid toolbar setting is set to None. If a grid such as Vessels (shown 

below) is selected, statistics are shown for each region. Use the Combine toolbar toggle to switch 

between separate and combined phase and amplitude polar maps or parametric surfaces. The 

additional controls made available in the info box (right side of the application) control display 

options such as a real-time graph cursor or display units, and the polar map toggle allows the 

regional display to be restricted to certain regions only. In 2 dataset mode the time-activity curves 

are hidden to make room for another set of histograms, and in 3 or 4 dataset mode the regional 

displays are hidden completely. Please refer to the Reference Manual for additional information. 
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4.14. Saving your Results 

With completion of the processing and reviewing steps outlined above, the user has the option of 

saving the results to a composite results file. From the main tool bar click Save to display the Save 

Results dialog window. 

 

 

There are two main choices available for saving results files, Results and PowerPoint. Selecting the 

Results tab (default) allows saving of processed results as a single file within the patient study.  
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Selecting the PowerPoint tab allows saving of results and application configuration information in a 

format that allows for fast and easy launching of case studies directly from a PowerPoint 

presentation. The PowerPoint saving feature is described in the reference guide.  

The following actions are supported: 

Save All Saves results for all selected studies 

Save Current Saves results for the currently display study. 

Cancel Exits the dialog without saving results. The user may also exit the dialog by 

clicking the “X” in the upper right-hand corner of the dialog window. 

 

4.15. Exiting  

To exit from any of the programs, click the Exit button. 
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5. Kinetic Analysis – Coronary Flow Reserve 
The Kinetic analysis feature for dynamic PET studies allows for automated quantification of absolute 

stress and rest blood flow within the myocardium using algorithms specifically developed for PET Rb 

and NH3 tracers.  It also allows for non-invasive determination of absolute coronary flow reserve 

(CFR).  The kinetic modeling method for Rb-82 is the 1-tissue compartment model (Lortie et al., 

EJNM 34:1765-1774, 2007).  Whereas the kinetic modeling method for Nitrogen-13 ammonia uses 

simplified 2-compartment model (Choi et al., JNM 34(3):488-497, 1993). 

 

The Kinetic feature requires at a minimum one processed transverse dynamic cardiac PET dataset 

however for the CFR results, both Rest and Stress dynamic cardiac PET datasets in the transverse 

format are required.  Kinetic analysis is designed to function with any number of frames but 

typically 16-26 frames are most commonly used in clinical settings. 

5.1. Kinetic page requirements 
The Kinetic feature requires at a minimum one processed transverse dynamic cardiac PET dataset 

however for CFR results, both Rest and Stress dynamic cardiac PET datasets in the transverse 



 
65 

format are required.  Kinetic analysis is designed to function with any number of frames but 

typically 16-26 frames are most commonly used in clinical settings. 

5.2. Kinetic page displays 
The Kinetic page displays quantitative results utilizing polar map, time/activity graph, and score 

chart formats. 

 Polar Maps-There are two rows of polar maps displayed on the Kinetic page. 

The polar maps displayed towards the top of the page show the stress and rest absolute blood flow 

in the Myocardium for the loaded datasets in ml/g/min.  If both Rest and Stress dynamic flow 

datasets are loaded, an additional CFR polar map showing the coronary flow reserve is also 

displayed.  The polar maps can be segmented into Vessels, Groups, Walls, and Segments using the 

grid pull down menu.  The values are averaged for the polar map pixels for each user defined 

segment. 

 

 

 

o The Polar maps displayed in the middle of the page show radiotracer activity within the 

myocardium in [(Bq/ml)/Time(Sec)].  There are up to 4 polar maps displayed in this region if 

both the rest and stress flow datasets are loaded.  Two of the polar maps show summed 

data that sums the information from all frames; the remaining two polar maps show data 

for the specific frame being displayed. 
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 Time/Activity graphs-The time/activity curves display radiotracer activity both within the 

blood pool of the right and left ventricles (left) and for the Myocardium (right).  When the 

Grid setting is set to Vessels, the Myocardium graph will also display the curves for each of 

the 3 main coronary blood vessels (LAD, LCX, and RCA).  The values in the time/activity 

graphs represent absolute radiotracer activity [Bq/ml]/Time[sec]. 

 
 

 Results (Scores)-The bottom right side of the screen shows results for absolute flow, CFR, 

and the spill-over fraction (SF) for each area of the Myocardium.  SF is the amount of 

radiotracer that has “spilled-over” into the Myocardium (as defined by the segmentation or 

contours) from the blood pool region for stress and rest.  The SF value helps the clinician QC 

the technical quality of the dataset.  A SF value of > 60% or 0.60 is considered to be of poor 

quality. 
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6. QARG Application (Quantitative Automatic Report Generator) 
QARG is a tool that, together with the ARG server produces comprehensive nuclear cardiac reports. 

QARG includes data collection utilities, data consistency checks, report generation, search utilities 

and several administrative tools. During the data collection process users are automatically 

prompted to resolve potential inconsistencies. Once the data acquisition is complete, the reports 

are generated. Reports not only contain derived values, but output clear sentences designed to 

send to the referring physician. QARG merges data from all sources to produce a single 

comprehensive report. 

6.1. How QARG and ARG work together 
The QARG client communicates with the ARG Server in the same manner QGS + QPS (with ARG) 

communicate with the ARG Server. Data collected via QARG resides in the same location as the data 

collected via QGS + QPS with ARG. Reports can be generated at any time from any application that 

supports ARG. All relevant consistency checks are also available from each application that supports 

ARG. 

 

                               QGS + QPS 

 

                    QBS 

 

 

QARG 

(Data collector + 
Connectivity Manager + 
Admin tools) 
 

-consistency rules (History & ECG) 

-input/review (History/ECG) 

-merge studies 

-manage & search for studies 

-QUANT input options 

-CTA reporting 

-Pyrophosphate reporting 

 

 

ARG 

(Database for storage) 

 
-generate PDF, text and HL7 reports 

-input/review (QUANT) 

-consistency rules (QUANT) 

-sign/un-sign reports 

-free-text dictation editor 

Report 
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6.2. Launching QARG 
QARG is the primary standalone program or “client” for working with the ARG database.  It allows 

user & site management, configuration, data entry and report viewing.  There are various ways of 

launching QARG; the most common ways are via the toolbar icon in CSImport or other vendor 

platforms.  

6.3. QARG security 
The fundamental security provided in QARG is via user authentication.  A user is required to login 

with his or her given username and password to have access to the program.  Users may be given 

different degrees of privilege regarding the ability to enter/modify/view data.  See the reference 

manual for details. 

6.4. QARG Main Window Layout 
The QARG home screen serves as the initial starting point for generating or viewing, new or existing 

studies.  Users logged in with administrative privileges can access administrative functions such as 

user and site manager. 

Other common functions include: 

New This function serves as the starting point for creating new reports. 

Open Opens selected study in a new study editor window. 

View Opens the report for the selected study in a new report viewer window. 

Search The search bar provides various options for searching existing ARG studies. 
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6.5. QARG Study Editor Window Layout 
New and existing studies are viewed and edited using the study editor window.  The window is 

broken up into sections for viewing and/or editing studies, interacting with patient data, viewing 

final reports, etc. 
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6.6. Typical workflow 
QARG – technologist 

1. Patient enters office and technologist creates a new study by selecting New on QARG’s main window. 
2. Technologist enters patient’s demographic and history. 
3. ECG test is performed and technologist fills out ECG section, and corrects any inconsistencies. 
4. Patient is imaged. 

 
Quantitative Application (QGS+QPS) – physician 

5. Physician uses QGS+QPS with ARG to automatically generate quantitative results, which are then verified 
and integrated with other inputs. 

6. Physician reviews demographic, ECG and quantitative information. 
7. Physician enters free-text dictation, if needed.  
8. Report is previewed. 
9. Report is signed. 
10. Report is sent to referring physician. 

 

 

6.6.1. Create a new study 

The user begins the process of creating a new study entry by pressing the New button on the 

main window. 
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The Create New Study window is 
presented allowing the user to enter 
information such as Patient ID, Test Date, 
Study Type, etc.  Once this information 
has been entered, press Next > to 
proceed. 
 
Note:  The Patient ID, Test Date, Study 
Type and Site fields must be filled in 
before the Next > button becomes 
enabled. 
 

 

 
 

If the specified Patient ID was found in 
the QARG database, the demographics 
will be filled in appropriately.  If it is not 
found, the dialog shown on the left will 
be presented, which provides options for 
entering new demographic information.  
Once it is completely filled in, press Finish 
to proceed.  The study will open in a new 
study editor window. 
 
Note:  Information entered while 
creating a new study can be edited later.  
 

 

6.6.2. History 

Clicking the History toolbar button displays the History Screen where users enter data into fields 

specific to the history of the patient.  The screen is divided into sections: Patient Characteristics, 

Patient Information, Other information (symptoms, Appropriate Use Criteria, etc.), Additional 
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History box and a Comments section. This information is commonly filled out prior to beginning the 

study upon patient arrival. 

 

 

 

 

 

 

 

 

After performing the ECG portion of the test, fields pertaining to the electrocardiogram and other 

protocol information can be completed.  The ECG section is available towards the bottom of the 

History screen and is divided into various sections. 
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6.6.3. Quant 

Once the exam is complete, the physician can use a quantitative application such as QGS+QPS.  If 

the quantitative application is integrated with ARG, it will contain a Report toggle that enables the 

ARG reporting panel within the application.  Most fields pertaining to quantitative results will 

already be filled in.  Clicking the Quant toolbar button displays the Quant screen shown below, that 

contains both sections of quantification in one screen, perfusion and function. 
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6.6.3.1. Polar maps 

Polar maps displayed at the bottom of the Quant screen allow viewing/modifying the visual scores 

for the study.  The specific maps visible are determined by the Sequence selected.  For example, if 

the Sequence is Rest-Stress-Late, there will be three polar maps labeled Str, Rst and Lte. 

 Left-clicking on individual scores in the polar map segments will cycle through the possible values. 

 Right-clicking on individual scores in the polar map segments will bring up a menu to allow modifying the 

vessel mapping of the segment. 

 Dragging and dropping (left-click and hold while moving) from the label (e.g. . ‘Str’) to another polar map 

will copy all scores from one polar map to another. 

 The 0 button sets all polar map visual scores to 0 

 The - button sets all polar map visual scores to ‘-‘ 

 The Grid button toggles between standard circular polar map presentation and a more tabular polar map 

presentation. 

 The Times button allows viewing/modifying the acquisition times for each sequence. 

 The Mo and Th allow toggling between the Motion and Thickening function polar maps 
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6.6.3.2. Coronary Calcium Scan 

When applicable, details of CT/CCS may be entered in the Coronary Calcium Scan dialog that is 

launched by clicking CT/CCS Details.  Detailed information about radiation dosage from CT 

(attenuation correction or a CTA scan) and Coronary Calcium Scan results may be entered using this 

section. 

 

6.6.4. Dictation screen 

The physician has the option to enter free text dictation from a quantification application 

(QGS+QPS) by selecting the Extended button within the reporting panel or by clicking the Dictation 

button on the QARG toolbar to display the Dictation screen shown below. The clinician may also 

add ‘canned’ sentences from the Custom Codes area, type in free-form text in the Dictation area, 

and add/edit/delete custom codes. The dictation screen allows the physician to enter free text as 

well as automatically generated sentences depending on the quantification information previously 

entered and values and customizable boiler-plate text.   
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6.6.4.1. Using Sentences 

 
 The Auto button inserts the automatically generated perfusion dictation.   

 The Comparison button inserts a phrase such as: ‘Compared to the previous study dated ----

-- there has been” 

 The Append button appends the selected canned sentence. 

 

Text in the main summary area may be modified directly.  Prefixing a code with the @ character 

directly in text will be replaced immediately with its value (e.g. @chest typed in the text window, 

would be the same as selecting ‘chest’ in the canned phrase window, and pressing Append). 

Words shown in red are words that are not found in the current dictionary (possibly misspelled).  

Right-clicking on words highlighted in red will bring up a list of possible alternatives found in the 

dictionary. 

6.6.4.2. Customizing Sentences 

The canned sentences available may be customized from within the program.  Pressing the New… 

button will allow adding a new sentence, while pressing Edit… will edit an existing one. 

 

6.6.5. Generating the report 

 

The report can be generated at any 

time. The report will include as much 

data as possible.  For example, if the 

perfusion section has not been 

collected, the report will not include 

any perfusion information.  

The report can be generated in PDF or 

ASCII Text by clicking the View button 

and selecting the report format (PDF 

or Text) or clicking the Report button 

in the relevant quantification 

application. 

  

 

6.6.5.1. Signing and un-

signing reports 
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When all of the data has been collected and the consistency checks verified, studies are ready to be 

finalized. Only users of type ‘Signing Physician’ can sign reports. Furthermore, only physicians listed 

on the report can sign a report. Physicians must enter their passwords to sign the report; once 

signed, it is locked from further modifications unless unsigned. The report is also archived (in the 

ARG database) during the signing process.  Signing and un-signing reports is accomplished by 

clicking the Sign (or Un-sign) button on the toolbar or from the Study menu.  Un-signing reports 

should be a very rare occurrence. Reports should only be signed once the data is reviewed and the 

report is ready to be sent to the referring physician. Un-signing allows physicians to correct 

erroneously signed reports. 

6.6.5.2. Viewing study logs 

Study logs provide an ownership and change history for each report. Each time report data is 

permanently modified or the study’s status changes the user responsible for the change as well as 

the time and action is logged. Each time the report is signed, an archive of the report (in both PDF 

and Text) is created. The archived copy can be viewed by clicking on the respective PDF or Text 

buttons from the View menu. Viewing the logs is performed by selecting Logs from the View menu 

item drop-down list. 

6.6.6. Administrating in QARG 

While logged in as an administrator, there are many administrative options available from the 

Admin menu.  

Name of Button Action 

Change Password... Opens dialog window  to change the current user password 

User Manager... Opens dialog window to create, delete and modify users 

Site Manager... Opens dialog window to add, edit and activate/deactivate sites 

Referring/Monitoring 
Physician Manager... 

Opens dialog window to create, delete and modify any referring and/or 
monitoring 

Camera Manager… Opens dialog window to create, delete and modify any camera systems 

Treadmill Protocol 
Manager… 

Opens dialog window to create, delete and modify any treadmill 
protocols. 

Report Editor... Opens dialog window to modify and select the template pages used to 
generate reports 

User Configurable Code 
Editor... 

Opens dialog window to edit, deactivate or create custom codes that are 
simple macros that store frequently typed sentences to be used. 

Blacklist Editor... Opens dialog window that allows user to activate any warnings that 
have been deactivated from being enabled 

Data Export... Opens dialog window to export reports to a designated folder 

Administrative Report… Opens dialog window to create customized, administrative reports 

Distribution Monitor… Opens dialog window  to view the distribution monitor. 

Global Preferences... Opens dialog window which will allow an Administrator to modify 
various global parameters. 

Connection Settings... Opens dialog window showing the Host ARG server being accessed 
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7. QBS Application (Quantitative Blood Pool) 
The QBS workflow is intentionally modeless. As such, no particular processing sequence is dictated 

to the user. A typical sequence might proceed as follows:  

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Load Datasets 

Repeat 

Reconstruction 

Raw Page 

Is there motion or 

incorrect acquisition (i.e. 

LV/RV is clipped) 

Slice Page 

Are contours incorrect?  

Manual (Page) 

Processing 

Splash Page 
Review 

rest/stress slices 

Surface Page 
Review surfaces 

Views Page 
Review views 

Results Page 
Review Polar Maps, Diastolic 

function, quantification data and 

time-volume curve  

(Phase page if available) 

 

Yes 

No 

No 

Yes 

Optional 

Integrated 
ARG 

Report 
(If available) 
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Note: QBS is able to quantify parameters of global and regional LV and RV function using only a 

short axis gated blood pool dataset. 

7.1. Launching QBS 

Launching QBS in its standard configuration will bring up the Main screen with the Slice page 

indicator and the Label, LV and RV toggles highlighted shown below. Representative slices are 

shown, with the number to the top-left of each slice showing its order in the short axis dataset. 

Left-clicking on Label toggles that number and the slice reference lines on and off.  

 

The name of the folder (generally, a patient name) and a description of the dataset are displayed in 

the horizontal section that also contains the color scales shown below. Left-clicking and dragging (in 

the Slices color scale) the vertical black stripe to the rightmost will “saturate” the scale and make 

the heart visible in cases where strong extra-cardiac activity exists. The Parametric color scale is 

available only if FFH Phase images are displayed on the Slice page. 
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7.2. Reviewing the Rotation Projection Images 
Clicking the Planar page indicator will bring up the Planar page shown below. The Planar page 

consists of four display areas; the raw Counts projection area, the FFH Amplitude area, the FFH 

Phase area, and the Phase Histogram area (FFH = First Fourier Harmonic).  

Prior to processing the data, it is always a good idea to view the raw projection data in cine fashion 

to assess patient motion. Clicking the Lines toggle brings up two horizontal lines, that should be 

manually positioned so that they tightly straddle the heart. Clicking the Controls toggle will bring up 

individual color scale and projection slider adjustment controls for the Counts, FFH Amplitude and 

FFH Phase display areas. A continuous loop cine display of the projection dataset(s) can then be 

started by clicking the Spin toggle (continuous rotation). Clicking the Rock toggle (in addition to the 

Spin toggle) will display an alternating, back-and-forth cine. The cine speed can be adjusted by 

clicking the ◄ ► symbols on the right side of the Rate label. Any sudden movement of the heart’s 

perceived boundaries towards, or away from the lines should be noted. Major motion may affect 

the quantitative parameters measured by QBS; if such motion is detected, it would be prudent to 

repeat the gated acquisition. 

       

In addition to patient or organ motion, flickering (sudden variations in brightness between adjacent 

projections) can be assessed by reviewing the projections cine. Flickering is often an indication of 

gating errors, and can be accompanied by alterations of the time-volume curves shown in the 

Results page. 

7.3. Processing the Images 
Clicking on the Slice page indicator will highlight it and advance QBS to the Slice page. Clicking 

Process will automatically apply the QBS algorithms to the data, segmenting the LV and RV, 
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Counts 

FFH 
Amplitude 

FFH 

Phase 

Phase 

Histogram 

Color scale 
controls 

Projection 
adjustment 
sliders 
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calculating the endocardial 3D surfaces, and determining all the global and regional quantitative 

cardiac parameters. The intersection of the 3D surfaces with the 2D slices planes are displayed as 

“contours” overlaid onto the six slices (yellow = RV, white = LV), which are now representative of 

equally spaced (short axis images) or mid-ventricular (long axis images) portions of the LV and RV. 

Moreover, all quantitative parameter fields in the right portion of the screen should now be filled 

with numeric values shown below. We’ll examine and discuss the quantitative measurements in 

more detail later. 

 

7.4. Checking the QBS Contours 
The location of the six slices displayed can be interactively adjusted by moving their corresponding 

slice reference lines in orthogonal views shown above; however, in most patient studies this will not 

be necessary.  

At this point, a visual check for obvious inaccuracies in the way the contours follow the LV and RV 

must be performed. This will likely involve toggling the LV and RV contour toggles on and off, and 

setting the images in motion (cine) by left-clicking the Gate toggle. Most major inaccuracies are due 

to the presence of extra-cardiac activity. In particular, one would expect to a) see the contours 

centered on a structure other than the heart, or b) see the contours “pulled away” from the 

ventricles to follow closely adjacent activity. These occurrences are infrequent, and should be dealt 

with using the Manual option discussed in the next section. 

Another potential source of error is excessive blurring of the short axis data. If the dataset was over 

filtered during reconstruction, it is possible that the algorithm will fail to differentiate between the 

Slice reference 
lines 

RV 

LV 
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left and right ventricles correctly. The ventricular contours may interpenetrate, or be completely 

erroneous.  

Note: Since the algorithm requires a phase difference between the ventricles and atria to correctly 

identify these structures, at this time it is not possible to obtain measurements from a static 

phantom, even if a gated acquisition was performed. 

7.5. Modifying the Contours (Manual Page) 
Clicking the Manual toggle will bring up a modified version of the Slice page, with 4 slices for the ED 

interval and 4 slices for the ES interval, as well as masking graphics superimposed upon the slices. It 

is possible to modify the shape and position of the masking graphics by left-clicking and dragging 

the masking graphic handles, small squares and circles placed at various points on the masking 

graphics.  

For each interval, two short-axis slices (mid-ventricular and apical), one mid-ventricular long axis 

and one mid-RV vertical long axis slice. Because of constraints imposed between the various points 

that constitute the mask, selection of the slices may be limited (as compared to slice selection in 

other pages).  The masking graphics are designed to achieve:  

 

 
Masking of extra-cardiac activity 

 
Separating between the LV and RV 
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Separation of the ventricles from the atria 

(Tricuspid and mitral separators) 
 

 
Separation of the RV from the pulmonary trunk 

(Pulmonary valve separator) 

 

In general, the following sequence should be followed for optimal placement of the mask: 

1. Start with the ED interval (left half of the page);  
2. adjust the HLA guide in the basal SAX slice to select a mid-ventricular HLA slice; 
3. move the whole mask in the HLA slice by dragging the square handle; 
4. adjust the circular handles for the septal and mitral separators in the HLA slice (this process 

may cause the selection of different SAX slices, just place the handles and slices in a way that 
allows for a good delineation of the septum in SAX and HLA views); 

5. adjust the circular handles for the septal separators in the SAX slices 
6. adjust the VLA guide in the basal SAX slice to select a mid-RV VLA slice, this will automatically 

adjust the first tricuspid handle in the HLA view; 
7. adjust the second tricuspid handle in the HLA view to correctly separate the RV from the RA; 
8. if RV Truncation is on, move the square pulmonary valve handle to the appropriate location; 
9. Adjust the orientation of the pulmonary and tricuspid valves in the SAX and VLA slices using 

the circular handles. 

Using a non-linear color lookup table may help in determining the best location for the various 

mask separators (in the example images, the “Cool” colormap is used). The following gives a 

graphical depiction of the mask placement steps. 
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Having correctly positioned the ED mask, use the Copy to ES >> button to copy the mask’s position 

to the ES interval. The correct ES interval should be selected manually by examining the image and 

visually determining in which frame the ventricles seem fully contracted. The program will 

automatically attempt to select the appropriate interval, but manual adjustment may be required. 

Is so desired, the mask can also be adjusted in the ES interval and copied back to the ED interval 

using the << Copy to ED button (note that the ES mask will completely replace the ED mask). 
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When the mask has been copied and the interval adjusted, repeat the above procedure for the ES 

interval. 

Shown below are the viewports from the manual page after positioning the ED and ES masks. 

 

Once the mask has been correctly positioned, click Process to process the data using the mask, or 

select Counts Only then click Process to perform count-based calculations only. Note that if Counts 

Only is selected, no surfaces will be generated and limited information only will be available in the 

Counts page. 

If the RV Truncation is off, no RV truncation will be performed. At any time, use the Reset button to 

reset the mask to its original (non dataset-specific) configuration. This will void all user changes. 

The remaining page controls (LV, RV, ED, ES, Blur, Smear, Gate, Mask, Frame, Zoom, and Rate) 

perform the same function as they do in the Slice page. 

7.6. Reviewing Gated SPECT Blood Pool Images in the Slice Page 
A first visual assessment of LV and RV function can be performed by left-clicking the Gate toggle to 

display a cine of the six slices while clicking the LV and RV toggles on and off. The cine speed can be 

adjusted by clicking the ◄► symbols on the right side of the Rate label. Moreover, a temporal and 
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spatial smoothing filter can be applied to the images by clicking the Blur and Smear toggles, 

respectively. This is especially useful to reduce statistical noise in low-counts images for visual 

assessment, and it will not affect the quantitative results.  Shown below is the Slice page set for 

review of gated images. 

Note: The Blur and Smear functions only affect image display. The QBS algorithms operate on the 

original, unsmoothed data regardless of Blur and Smear settings. 

At Cedars-Sinai Medical Center, a gray or thermal scale is typically used to visually assess wall 

motion. 

 

 

7.7. Reviewing Gated SPECT Blood Pool Images in the Splash Page 
Clicking on the Splash page indicator will bring up the Splash  page shown below, with all the 

available short images, which can be then gated simultaneously by left-clicking the Gate toggle. At 

times, a user may want to select images for closer inspection. This is accomplished by using the 

“popout” feature. This is performed by right-clicking on the desired images to select/deselect them 
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(the corners of the selected items are highlighted in blue), then left-clicking on the Popout toggle 

shown on the bottom. 
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Splash page after Popout enabled 
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7.8. Reviewing Gated SPECT Blood Pool Images in the Surface Page 
Clicking on the Surface page indicator will bring up the Surface page shown below; a parametric 

representation of the ventricles, consisting of green wireframe surfaces (ventricular ED 

endocardium) and shaded surfaces (ventricular endocardium). The Gate toggle allows the user to 

follow the 3D wall motion throughout the cardiac cycle, while clicking and dragging on the image 

will interactively and in real time position it to the observer’s liking. 

 

It is also possible to display an isosurface extracted from the counts data. This surface can 

potentially be used to visually assess wall motion as well, though no isosurface (at any level) gives 

the location of the endocardium. The user can then superimpose the calculated surfaces onto the 

isosurface display. The best way to do this is to display the LV and RV surfaces as wireframes (red 

and blue, respectively) along with the shaded isosurface. To minimize noise effects in the isosurface 

extraction, it is recommended to toggle on temporal smoothing by clicking the Blur toggle. Display 

characteristics can be set separately for the LV and RV using the appropriate option menus. 



 
90 

7.9. Reviewing Gated SPECT Blood Pool Images in the Views Page 
Clicking on the Views page indicator will bring up the Views page with six 3D viewports shown 

below, very similar to that in the Surface page. In fact, the main purpose of this page is to allow full 

coverage of the LV and RV, albeit with smaller images compared to the one in the Surface page. 

 

 

 

7.10. Putting it All Together: The Results Page 
Clicking on the Results page indicator will bring up the Results  page shown below, which aims at 

presenting, in synthetic format, all information related to the gated SPECT blood pool study in this 

patient. If a screen capture is taken of this page with the LV and RV contour toggles off, it would 

represent a good image to send the referring physician. 
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Results page 

7.10.1. Assessing the Time-Volume Curve 

A valid time-volume curve would be expected to have its minimum (end-systole) at frame 3 or 4, 

and its maximum (end-diastole) at frame 1, 7 or 8 of an 8-frame gated acquisition. For a 16-frame 

gated acquisition, the minimum (end-systole) would be expected to be at frame 7 or 8 and its 

maximum (end-diastole) at frame 1 or 16. If major deviations from this expected behavior occur, 

the prudent assumption is that gating or processing was unsuccessful and the study needs to be 

repeated. An example of a correct curve is shown above.  

Note: In the time-volume curve graph, the volumetric value for interval 1 is also “appended” to the 

curve after interval 8 or 16, respectively, for 8-frame and 16-frame gated acquisitions. 

7.10.2. Assessing the Polar Maps 

QBS provides two wall motion polar maps, one each for the LV and RV. 

Mapping of the endocardial motion in the motion polar map follows a linear model from 0 mm to 

10 mm. Motion greater than 10 mm is assumed to be = 10 mm (the scale "saturates" at 10 mm), 

while motion <0 mm (dyskinesia) is assumed to be = 0 mm. The parametric surfaces displayed on 

the Results page are not normalized to this 10 mm limit but to the maximum wall motion value 
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instead. The FFH Amplitude polar maps and surfaces are not normalized in any way. The FFH Phase 

polar maps and surfaces are displayed in such a manner than angles between 0 and 360o span the 

color stripe (negative angles wrap around to the 0-360 range, i.e., -20o is displayed as 340o). Note 

that paradoxical motion would appear to have a non-zero amplitude and a phase value opposed to 

normal areas (i.e., the color of the phase will correspond to a different portion of the parametric 

color stripe). 

Note: It is well known that, even in normal patients, the septum typically moves less than the lateral 

wall (resulting in a “dark” area in the motion map). 

7.10.3. Diastolic Function 

Clicking the Diastolic  toggle replaces the LV and RV volumes curves with LV and RV volume and 

filling curves as well as computed diastolic parameters. The user may have to scroll down the Info 

box or maximize the QBS window to see all the computed parameters. 

 

Diastolic results 

7.11. Phase Analysis 
With the optional “PlusPack” component, QBS offers a phase analysis page with global and regional 

histograms and parametrically-mapped surfaces. Clicking the Phase page button brings up the 



 
93 

phase analysis page. Detailed statistics and timing differences between regions can be found in the 

info box (right side of the application). The user may have to scroll down the Info box or maximize 

the QBS window to see all the computed parameters. 

 

 

7.11.1. Pixel Size 

QBS volume measurements can be hampered by incorrect listing of the pixel size in the image 

header (this is usually not a problem with the ejection fractions, which are derived from a ratio of 

volumes). Pixel size is usually automatically calculated by modern cameras, based on knowledge of 

field of view and zoom information. However, older cameras or "hybrid" systems (where one 

manufacturer's camera is interfaced to another manufacturer's computer) may not be set up to 

transfer pixel size information from the gantry, or may take a "standard" size (i.e., 1 cm) as default. 

In these cases, a correction factor should be manually calculated by imaging a known pattern (for 

example, two line sources separated by an exact distance), and counting the number of pixels 

between the lines' centroids in the reconstructed transaxial image. 
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7.12. Saving your Results 
With completion of the processing and reviewing steps outlined above, the user has the option of 

saving the results to a results file. From the main tool bar click Save to display the Save Results  

dialog window as shown below. 

 

There are two tab choices for saving, Results and PowerPoint. Selecting the Results tab (default) 

allows saving of processed results as a dataset within the patient study. The user gives the results 

dataset a name that will appear in the patient study dataset list upon exiting QBS. In some cases, 

there may be an additional option to select the format of the results file. This is to ensure some 

compatibility with older versions of the software. Note that all calculation results from the most 

recent version may not be available in older versions of the software. 

Selecting the PowerPoint tab allows saving of results and application configuration information in a 

format that allows for fast and easy launching of case studies directly from a PowerPoint 

presentation.  

The following actions are supported: 

Action Purpose 

Save All Saves results for all selected studies 

Save Current Saves results for the currently displayed study. 

Cancel Exits the dialog without saving results. The user may also exit the 

dialog by clicking the “X” in the upper right-hand corner of the dialog 

window. 
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8. AutoRecon Application (Automated Reconstruction)  
AutoRecon is an optional application for the automatic and manual reconstruction, reorientation 

and motion correction of Cardiac, Brain, other (liver, bone, etc) SPECT and gated SPECT datasets.  

The amount of automation and processing options provided by AutoRecon depends upon the type 

of dataset selected.  AutoRecon applies validated rules to reconstructing and reorienting projection 

images, and reduces the number of decisions required when processing studies. 

8.1. Launching AutoRecon 
Launching AutoRecon in its standard configuration will bring up the Reconstruct page with the 

selected dataset(s) loaded as shown in the figure below. 

 

 

 

8.1.1. Top Panel Controls 

The AutoRecon top panel controls allow you to perform application functions such as selecting 

defaults files, saving files, or formatting images.  You can access most of these controls regardless of 

Top Panel Controls Image Controls Patient Selection 
Controls 

Main Window 
Controls 
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the currently displayed AutoRecon window.  A brief description of some of the buttons contained in 

this panel is shown below. 

 

 Recon - Clicking it will manually reconstruct the currently displayed dataset(s).  To manually 

process a dataset, define the reconstruction limits, verify and adjust the main window 

controls as desired and then click the Recon button.  AutoRecon does not automatically 

advance to the Reorient window when using the Recon button.  If Motion Correction type is 

set to Auto, the Motion window will be displayed after reconstruction of the dataset(s) has 

commenced. 

 Reset Page - Clicking it will restore the processed dataset(s) and viewport settings to their 

initial values.  It also removes any processed dataset(s) that have not been saved. 

 Copy Page - Clicking it will copy the processing settings from one set of viewports to all 

other objects loaded in memory. 

 Auto All - Auto All is only available for cardiac dataset(s).  Using this option will 

automatically determine the reconstruction limits, reconstruct and reorient cardiac 

dataset(s).  Auto All generates the transverse slices, proceeds automatically to the 

Reconstruct window, and automatically reorients the ventricular volume.  If Motion 

Correction type is set to Auto, the Motion window will be displayed after reconstruction has 

commenced using the motion corrected dataset(s). 

 Auto Recon - This option automatically determines the reconstruction limits and 

reconstructs the cardiac dataset(s).  Auto Recon automatically generates the transverse 

slices, but does not proceed to the Reorient window.  If Motion Correction type is set to 

Auto, the Motion window will be displayed after reconstruction has commenced using the 

motion corrected dataset(s). 

 Auto Reorient - Clicking it will automatically reorient cardiac dataset(s).  If you have not 

reconstructed the dataset(s), Auto Reorient will reconstruct and then reorient the datasets.  

If Motion Correction type is set to Auto, the Motion window will be displayed after 

reconstruction has commenced using the motion corrected dataset(s). 

 Defaults - The Defaults field displays the name of the currently selected default settings. 

 

8.2. Workflow 
Typical processing sequence for Cardiac datasets in AutoRecon might be as follows: 

 

1) Load desired dataset(s) from the patient browser and click AutoRecon button. 

2) From the Reconstruct Page, click Auto All to automatically reconstruct and reorient the 

unprocessed SPECT or gated SPECT cardiac datasets, Auto Recon to automatically generate the 

cardiac SPECT or gated SPECT transverse dataset, Auto Reorient to automatically reorient the 

cardiac SPECT or gated SPECT transverse datasets.  
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Note:  If you have not reconstructed the transverse dataset, Auto Reorient will automatically 

reconstruct the dataset prior to reorienting the dataset.  AutoRecon will automatically proceed 

to the Reorient window if Auto All or Auto Reorient options were selected. 

 

3) Evaluate the images to ensure no further manipulation is necessary by checking the following 

pages: 

 

(1) Reconstruct page 

a. The reconstruction limits should completely enclose the left ventricle and be symmetrically 

placed above and below the left ventricle less than 5 pixels from the ventricle. 

b. The reconstruction limits should not clip the left ventricle. 

Note:  If the reconstruction limits are not properly determined, you can manually process the 

cardiac dataset(s).  Press the left mouse button and drag the reconstruction limit lines close to 

the ventricle, and then left click the Recon button.  If motion correction type is set to Auto, the 

Motion window is displayed after reconstruction. 

             

               
\Reorient page 

Reconstruction 
Limit Line 

Transverse Slice 
Reference Line 

Reconstruction 
Limit Line 

Pre-reconstruction Post-reconstruction 
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a. The reoriented left ventricle should be visible in the Short Axis, Vertical Long Axis, and 

Horizontal Long Axis viewports. 

b.Verify placement and orientation of the Azimuth line in the Transverse viewport. 

c. Verify placement and orientation of the Elevation line in the Sagittal viewport. 

 

Note:  If necessary, manually reorient the ventricle.  Left click and drag the circle on the 

Azimuth or Elevation reference line to the center of the ventricle.  Left click and drag the ends 

of the Azimuth or Elevation reference line in the direction that you want to orient the ventricle.  

Left click and drag the dataset reference lines so that they are close to the ventricle but not 

clipping the ventricle. 

         
 

 

(2) Motion page 

The Motion page houses the MoCo (Cedars-Sinai Motion Correction) application, which is 

used for automatic and manual correction of SPECT acquisition motion artifacts.  Datasets 

will be automatically corrected for motion artifacts if the motion correction type is set to 

Auto on the Reconstruction page.   

 

a. Verify that any motion artifact has been accurately corrected for. 

Pre-reorientation Post-reorientation 
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Note:  To manually correct for motion, step through each slice in the reference viewport, move 

the image in each slice as needed to align the images using the motion correction clickers.  

Change the motion correction type to Manual on the Reconstruct page to reconstruct the 

study with the manually motion corrected dataset(s). 

 

 

                    

 

 

4) Save Page 

a. Enable the toggle boxes for each dataset that you want to save and verify that the View IDs 

are correct. 

b. Left click on the Save button to save the datasets. 

 

 CAUTION:  Do not confuse the Save Page option with the Save button in the far right 

side of the Top Panel Controls.  The Save button saves all of the datasets without allowing 

you to change the save parameters. 

 

Horizontal Reference 

 Lines 

Motion Correction 

Clickers 

Reset 

Motion Correction Viewports 
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5) Left click on the Exit button to exit AutoRecon. 

 

9. MoCo Application (Motion Correction) 
MoCo is constructed from the following components: 

Viewport Display Images and results display 

Color Control Selects current color scale and intensity mapping. 

Dataset Selector Selects the currently displayed dataset. 

Viewport Control Controls display of viewports 

MoCo Control Controls automatic and manual motion correction processing and 
validation. 

9.1. Viewport Display 

 

Save Page option Save button 

The Save Window 
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The interface, which does not include externally accessible exit or save functionality as it is intended 

primarily to be embedded in a containing application, is constructed from the following 

components: 

Original 
Projection 
Viewport 

Displays a single projection from the uncorrected dataset.  The current projection 
is selected by its corresponding scrollbar; horizontal motion reference lines are 
moved by dragging. 

Corrected 
Projection 
Viewport 

Displays a single projection from the corrected dataset.  The current projection is 
selected by its corresponding scrollbar; horizontal motion reference lines are 
moved by dragging.  The motion correction x and y axis offsets are also displayed. 

Original 
Sinogram 
Viewport 

Displays a single sinogram from the uncorrected dataset.  The current sinogram is 
selected by dragging the sinogram reference line in the corresponding projection 
viewport. 

Corrected 
Sinogram 
Viewport 

Displays a single sinogram from the corrected dataset.  The current sinogram is 
selected by dragging the sinogram reference line in the corresponding projection 
viewport. 

X-axis Motion 
Graph 

Displays the current x-axis motion correction offsets. 

Y-axis Motion 
Graph 

Displays the current y-axis motion correction offsets. 

Motion Cursor Manually selects the x and y axis motion correction offsets.  Also selects the 
current projections for the Original and Corrected Projection Viewports. 

9.2. Color Control 

 

Two color scales exist: Raw controls most images which include the projections, sinograms and 

cyclogram displays. Slices controls the single slice displays, which is only available when Mask or 

Cyclogram is selected.  

The Color Control is used to select the current color scale and intensity mapping.  The color scale is 

selected by clicking on the color scale option menu and choosing from the ensuing list of available 

color scales.  The intensity mapping is set using two parameters, the lower and upper levels, either 

of which can range from 0 to 100 percent.  They together specify that portion of a dataset’s 

dynamic range that is to be mapped onto the full color scale. 

The lower and upper levels of the intensity mapping, represented with the lower and upper level 

bars, can be set through the color scale viewport, which supports the following interactions: 

 Left drag either level bar to move it. 

 Left drag any other point on the viewport to move both level bars simultaneously.  

 Middle click or drag any point on the viewport to move the closer level bar to that point. 

 Double left click anywhere in the viewport to reset the level bars to 0 and 100. 
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The following features are also provided through the option menu: 

Reset Resets lower and upper levels. 

Invert Toggles the sense of the lower and upper levels. 

Step Toggles color scale discretization. 

Gamma Toggles display of color scale gamma control. 

Expand Toggles dynamic range expansion of lower and upper levels. 

Normalize Toggles automatic dataset normalization based on segmentation results. 

9.3. Dataset Selector 

At start up the application is passed a list of one or more datasets as input.  The dataset selector 

selects from this list the current dataset, i.e. the dataset to be viewed.  It allows the user to page 

through the datasets by clicking the arrow buttons.  In addition, the user can jump directly to a 

dataset by clicking on the dataset option menu; this pops up a list of available datasets from which 

the desired dataset can be selected. 

9.4. Viewport Control 

 

Label Enables viewport labeling including slice and projection numbers and motion reference 
lines. 

Enhance Applies a spatial filter designed to enhance motion artifact visibility to the original and 
corrected projection sequences. 

Spin Toggles projection cine. 

Scan Toggles the sinogram cine.  

Rock Toggles bi-directional projection cine for sub 360 acquisitions (with spin also enabled). 

Rate Selects the cine and scan speeds. 

 

9.5. MoCo Control 
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The MoCo Control is used to control automatic and manual motion correction processing and 

validation.  The following controls are available: 

Cyclogram Enables cyclogram display mode.  When enabled the sinogram viewports are replaced 
with their corresponding cyclogram viewports.  A cyclogram is constructed by 
compositing the set of vertical strips defined by the intersection of each projection in 
the projection sequence with a plane constrained to be perpendicular to the projection 
and to the transverse plane and further constrained to intersect a user specified point 
in the transverse plane.  A cyclogram accentuates horizontal (x-axis) motion artifacts in 
a manner analogous to a sinogram’s accentuation of vertical (y-axis) motion. 

Correct Initiate automatic or semi-automatic motion correction. 

Clear Reset all motion correction offsets to zero. 

X-axis Enable x-axis motion correction. 

Y-axis Enable y-axis motion correction. 

Mask Enable masking mode.  When enabled an additional transverse slice viewport is 
enabled allowing the user to define a transverse volume delimited by an ellipse and 
lower and upper slice bounds upon which the motion correction algorithm should 
focus its efforts. 

Det Selects the number detector heads, permitting differing constraints to be used by the 
motion correction algorithm based on the camera geometry. 
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10. Viewer 
The viewer application allows the display of image files on a mobile viewing platform.  The workflow 

is intentionally modeless and no particular processing sequence is dictated to the user.  A typical 

sequence might proceed as follows:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

10.1. Requirements 
The viewer application is supported on iPad 2, iPad (3rd generation), iPad (4th generation) and iPad 

Mini.  It requires results files generated from Cedars-Sinai Cardiac Suite version 2013 or newer.  

Results files from older versions of the suite (Suite 1.0 – Suite 2012) can be made compatible for the 

viewer by either uploading them using version 2013 or by using a standalone up-loader tool that 

shall convert the results file into a compatible format before up-loading them to the central server. 

The viewer application presently supports Nuclear Cardiology SPECT images only. 

Load desired study from the 

study selector 

Raw Page 
(Check for motion and/or 

artifacts) 

Splash Page 
(Review rest/stress slices) 

Results Page 
(Review polar maps, 

quantification data, visual scores, 
time-volume curve, etc) 

Surface Page 

Snapshot Page 

Slice Page 
(Check contours) 

Optional 
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10.2. Launching 
The viewer application can be 

downloaded on compatible devices 

from the Apple App Store.  Once 

downloaded, the application can be 

launched by selecting its icon.  The 

viewer application will include 

default demo cases when the app is 

first downloaded.  For purposes of 

this example, we will use one of 

these demo cases. 

 
 

 

10.3. Study selector 
Launching the viewer app in its standard 

configuration will bring up the study 

selector screen with a few default demo 

cases.  Select the desired study to 

proceed.  For purposes of this example, 

we will use one of these demo cases to 

review different application screens.  The 

study selector can also be launched by 

clicking on the currently selected 

patient’s name and clicking Select New 

Study. 

 

10.4. Page selector 
The viewer application intentionally 

provides a modeless review 

environment. The page selector tool 

can be used for navigating between  

different pages. 
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10.5. Contrast and brightness 

 

The viewer application contains an interactive tool to ensure adequate image contrast is viewable in 

different ambient lighting conditions.  A sample image from this tool is show below.  If the user is 

not able to successfully identify the dark grey areas within the black background, the viewer 

application shall proceed to running in non-diagnostic mode.   

The screen brightness level can be adjusted by navigating to settings > Brightness & Wallpaper. 
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10.6. Dataset selector 
The viewer application supports 

displaying data in up to 2 dataset 

mode.  Desired datasets maybe 

selected using the dataset selector.  

Only datasets that are supported 

on the currently selected page are 

displayed in the dataset selector 

(e.g., only raw projection datasets 

are available on the Raw page). 

 

 

10.7. Reviewing the rotating projection images 

The Raw page can be used to view raw projection images.  A continuous loop cine display of the 

projection data sets can be started by clicking Spin (0 to 360 degrees continuous rotation). Clicking 

Rock toggle (in addition to the Spin 

toggle) will display an alternating 

cine (0 to 180 degrees and 180 to 0 

degrees rotation). The cine speed 

can be adjusted by clicking the 

 icons. Any sudden 

movement of the LV’s perceived 

boundaries towards or away from 

the lines should be noted, as should 

a uniform upward drift (upward 

creep of the heart, often associated 

with the diaphragm’s return to its 

normal position soon after 

exercise).  
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10.8. Checking the contours 

The slice page can be used to 

visually check for obvious 

inaccuracies in the way the 

contours follow the LV.  This 

will likely involve clicking the 

LV toggle on and off, and 

possible setting the images in 

motion by click the Gate 

toggle. The location of the 

five slices displayed can be 

interactively adjusted by 

moving their corresponding 

slice reference lines in 

orthogonal views; however, 

in most patient studies this 

will not be necessary. Both the stress and the rest short axis datasets can be visualized 

simultaneously, which also splits the display in two as shown below. The stress images are displayed 

on the left half and the rest images on the right half of the display. 

10.9. Reviewing Gated or Un-gated SPECT Images on the Splash Page 

Although the Slice page can 

be useful to make a quick 

initial determination on the 

presence and location of 

perfusion abnormalities, 

accurate perfusion 

assessment must precede 

from the entire short axis 

datasets. Clicking on the 

Splash page indicator will 

bring up all the available 

short axis images.  When 

applicable, the images will 

be displayed in interleaved 

fashion for the stress and the 

rest studies, as show below. 

In essence, the first dataset to appear in the Info box will correspond to rows 1, 3, 5 and 7 of the 

display, the second dataset to rows 2, 4, 6 and 8. Stress and rest images are automatically chosen, 

and ought to be well aligned.  The images can be manually aligned by dragging the appropriate row 
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of images towards the left or right. Gated images can be viewed simultaneously as cine by clicking 

Gate.   

A spatial smoothing filter can be applied to the images by turning on the Smear toggle on the page 

control bar. This is especially useful to reduce statistical noise in low-counts images for visual 

assessment, and it will not affect the quantitative results.  

10.10. Reviewing SPECT Images on the Surface Page 
Clicking on the Surface page 

indicator will bring up the Surface 

page shown below; a parametric 

representation of the LV, consisting 

of a wireframe surface (epicardium) 

and a shaded surface (endocardium) 

is displayed. This type of display is 

not as useful for perfusion as it is for 

gated SPECT data, but can 

nevertheless aid in assessing LV size 

and shape. Clicking Gate allows cine 

display to follow the 3D 

endocardium and epicardium 

movement throughout the cardiac 

cycle, while clicking and dragging on 

the image will interactively and in real time position it to the observer’s liking.   

10.11. Putting it All Together: the QPS Results Page 
Selecting QPS Results from 

the page selector will bring 

up the QPS Results page, 

which aims at presenting, in 

synthetic format, all 

information related to the 

perfusion SPECT study for 

the patient. Two datasets 

are typically displayed on the 

Results page.  

The results page provides 

three perfusion polar maps 

and three 3D parametric 

surfaces (stress, rest and 
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reversibility). The Function menu (available from the Grid menu) contains the options: Raw, 

Severity, and Extent, all of which apply to both 2D and 3D displays. A grid of 20-segments 

(Segments), 3 vascular territories (Vessels) or 4 regions (Walls) can be overlaid onto all polar maps 

and surfaces from the Grid pull-down menu. Both stress and rest perfusion values are normalized to 

100. 

 

10.12. Putting it all together: the QGS Results page 
Selecting QGS Results from 

the page selector will bring 

up the QGS Results page, 

which aims at presenting, in 

synthetic format, all 

information related to the 

gated SPECT study for the 

patient.  QGS Results page 

only support displaying in 1 

dataset mode.  End-diastolic 

and end-systolic short axis 

slices and 3-D surfaces will 

be displayed and the latter 

can be cined by clicking 

Gate.   

 

10.13. Image controls 

The following common controls are available for the viewer app.  Refer to the reference manual for 

a complete list of image controls. 

 This control has multiple functions that can be accessed by expanding the menu: 

 Ability to change color palette  

 Ability to modify background level 

 Ability to modify image brightness level 

 Ability to Invert, step and Reset the color scale to their default settings 

Blur Toggles temporal (inter-frame) smoothing.  

Smear Toggles spatial (inter-slice) smoothing. 

Gate Toggles temporal (inter-frame) cine. 

Rock Toggles bi-directional projection cine for sub 360 acquisitions (with spin also enabled). 

LV Toggles LV contour display on and off 

ED Toggles LV-ED contour on and off 

ES Toggles LV-ES contour on and off 
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11. Troubleshooting 
Symptom: I receive a "database connection failed" error message when launching QPS or QGS 

Resolution:  

1. Verify that ARG Server has been correctly installed.  

2. Verify that the ARG Server is reachable over the network (try "ping [argserver]" from the 

command prompt, where argserver is the IP address of the arg server) 

 

Symptom: I can't push images to CSImport from my camera.  

Resolution:  

1. Verify that both systems have been configured correctly; consult the connectivity section of  

CSImport configuration, and the camera vendor's user manual. 

2. Verify that the windows firewall has an exception for the Cedars-Sinai DICOM Store 

3. Verify that the "pushing" workstation is able to reach the CSImport station (try "ping 

[csimport_ip]" from the command prompt on the camera's  workstation, where csimport_ip is the 

IP address of the CSImport machine) 

 

Symptom: In QPS I receive "multiple matches" when opening a dataset 

Resolution:  

1. Verify that the necessary matching fields (e.g. patient sex) are getting populated. If they are not, 

they will show up in yellow in the dataset editor window. If fields are not correctly populated this 

could indicate an error with the DICOM data. Contact the camera manufacturer for more 

information.  

2. Note the sex, isotope, and acquisition state for the dataset.  

3. Open the Database page, select "List..." verify that there is only 1 active database for 

sex/isotope/acquisition state combination. If more than one active databases are present, open the 

database which should not be selected, turn off "allow automatic selection" and save. 
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